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1. Introduction 

1.1. Overview 

The C2K Automatic Test System (C2K-ATS) provides an integrated test solution for 
evaluating parametric performance and signaling conformance of Third Generation (3G) 
CDMA mobile devices. A turn-key system is produced by combining a C2K-LAB (SR5500 
Wireless Channel Emulator), AirAccess C2K base station emulator (two SR3452v2 units), 
and essential CDMA test equipment. 

TASKIT/C2K Windows software automates mobile testing by configuring the 
instruments, stepping through the test sequences, and logging the results.  

By removing much of the burden of manual test setup and configuration, C2K-ATS solves 
the following testing issues: 

• Selecting the correct instruments and necessary system hardware. 

• Translating the test standards into instrument settings. 

• Writing software to automate test sequences. 

• Logging test results. 

• Reproducing test configurations. 

C2K-ATS allows wireless service providers and equipment manufacturers and developers 
to evaluate 3G mobile products relative to industry-standard test requirements and  
user-defined test conditions. 

1.1.1. Product Highlights 

C2K-ATS meets and exceeds industry standards for 3G CDMA mobile testing. 

CDMA test specifications require the performance of mobile stations to be evaluated 
over a variety of propagation and interference environments. To perform these tests, a 
system that emulates the essential propagation and interference conditions is required. 
In addition, these test beds require additional functions such as system control and 
configuration, RF power measurement, and level control.  

To perform mobile station signaling conformance tests, the Layer 2 and Layer 3 protocol 
on the base station emulator must be monitored and customized. 

C2K-ATS combines all elements required for these tests into one integrated system. 
When coupled with a base station emulator, C2K-ATS provides a complete end-to-end 
test solution for TIA, CDG, and 3GPP2 tests. When controlled by TASKIT/C2K, the C2K-ATS 
automatically executes these mobile tests and logs test results. 
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TASKIT/C2K provides the ability to begin running automatic performance tests in a 
matter of minutes. 

TASKIT/C2K for Windows provides an easy-to-use graphical user interface for automating 
CDMA mobile device tests. Pre-defined tests taken from industry standards can be 
loaded and running in minutes. This comprehensive software also facilitates creation of 
custom test conditions to find the performance limits of the device under test. Whether 
running pre-defined or custom tests, all results are logged in a Microsoft Access 
database. TASKIT/C2K’s built-in results viewer allows results to be viewed and printed in 
a variety of standard formats. 

C2K-ATS interfaces directly to the mobile station under test. 

UniversalDM allows C2K-ATS to interface directly with the mobile station under test. This 
interface consists of software and a cable to connect the PC and the mobile device. This 
powerful feature relieves you from collecting key information about the mobile device, 
such as ESN, software version, and the PRL (Preferred Roaming List). TASKIT/C2K 
retrieves this information automatically to streamline mobile device testing and results 
management. 

C2K-ATS is based on advanced Spirent Communications emulation instruments. 

Every C2K-ATS includes the Spirent Wireless Channel Emulator and the TAS5048 and 
SR5068 Test Configuration Unit (TCU). These instruments provide the most integrated 
and powerful solutions available for evaluating mobile receiver performance.  

The Spirent Wireless Channel Emulator implements a superset of all RF channel 
conditions required for CDMA receiver testing, such as multi-path fading, delay spread, 
and path loss as well as Additive White Gaussian Noise (AWGN). Dynamic 3GPDP 
channel models characterize rake receiver performance. 

The TAS5048 and SR5068 Test Configuration Units are controlled by TASKIT/C2K to 
automatically select from a list of pre-defined test configurations. These instruments 
eliminate the need to manually configure the system, thereby optimizing test execution 
speed. 

The set of AirAccess CDMA Network Emulators (Two SR3452v2s) is a scalable 
performance analysis solution for CDMA terminal manufacturers and service providers. 
AirAccess features a highly programmable protocol processing engine to provide 
complete emulation of a multi-cell CDMA network. 
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1.1.2. C2K-ATS Applications 

C2K-ATS yields thorough testing of 3G CDMA mobile devices in a laboratory setting. In 
doing so, C2K-ATS gives accurate and repeatable test results, allowing performance 
problems to be detected, isolated, and corrected in the shortest possible time. C2K-ATS 
eliminates the need for expensive, labor-intensive “home-brew” test systems and can 
drastically reduce the time spent doing field tests whose conditions cannot be controlled 
or repeated. Applications for C2K-ATS include: 

• Product Development 

• Design Verification 

• Product Qualification 

• Conformance Test 

• Competitive Analysis 

• Performance Analysis 

1.2. Theory of Operation 

C2K-ATS is a complete, integrated system for evaluating the performance of 3G CDMA 
mobile terminals. This system includes all the test instruments and control software 
required to accurately emulate the bi-directional end-to-end connection between the 
base station emulator and mobile station under test. The signaling protocols and air 
interface specifications between these two devices have been defined in industry 
standards such as IS-2000. An overview of the network model is presented below. 

1.2.1. Base Station to Mobile Station Network Model 

The Base Station – Mobile Station connection is a frequency division duplex (FDD) RF 
link, as shown in Figure 1-1. The Base Station to Mobile Station link is considered the 
Forward Channel. Conversely, the Mobile to Base Station link is termed the Reverse 
Channel. The Forward and Reverse Channels operate at independent carrier frequencies. 
They transport voice, data, and signaling information between the Base and Mobile 
Stations by means of a spread spectrum carrier. 

Ior Ior Io
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Figure 1-1: Mobile Station – Base Station Network Model for Demodulation of the Forward Channel with Fading and Noise 
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Typically when assessing the performance of mobile stations, the Forward Channel is 
impaired while the Reverse Channel is left uncorrupted. This is done to evaluate the 
ability of the mobile station to demodulate the transmit signal from the base station 
under adverse conditions. Industry standards require the mobile station to be 
characterized under the influence of multi-path propagation effects as well as additive 
co-channel and adjacent channel interference. Co-channel interference is approximated 
by Additive White Gaussian Noise (AWGN) while Continuous Waveform (CW) signals are 
utilized to act as adjacent channel interferers. 

Test standards define typical propagation channel models which range from one to three 
paths. Each path undergoes Rayleigh fading and, for models with multiple paths, relative 
path-to-path delay and attenuation are also specified. A typical test model involving 
fading is shown in the figure above. 

Due to frequency re-use requirements, signals transmitted in nearby cells propagate 
beyond their own cell boundaries and interfere with the signal reception in bordering 
cells resulting in co-channel interference. To emulate these interference conditions, test 
standards require various levels of AWGN be combined with the transmitted signal to 
approximate the interference created by users in other cells. To test the selectivity of the 
mobile station, tests have been specified to simulate users operating at carrier 
frequencies adjacent to the channel of the mobile under test. This is accomplished by 
summing single or dual CW signals with the Base Station transmit signal to act as 
adjacent channel interferers. A typical test model involving co-channel or adjacent 
channel interference is shown in Figure 1-2.  
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Figure 1-2: Mobile Station – Base Station Network Model for Demodulation 

1.2.2. C2K-ATS Network Model 

Meeting the specifications of the Mobile Station-Base Station Network Model discussed 
above requires sophisticated instruments capable of emulating the test environments in 
an accurate and repeatable manner. To be truly beneficial, these instruments must also 
be capable of emulating conditions beyond the minimum requirements defined by the 
industry test standards. By providing a broader range of test conditions, the system can 
be used to find the performance limits of the mobile station under test. 
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C2K-ATS allows for three main configurations of the Mobile Station-Base Station Link. 
This is made possible with the TAS5048 and SR5068 Test Configuration Units. The first 
configuration utilizes the SR5500 Spirent Wireless Channel Emulator in the forward path 
to provide impairments. In addition, a Base Station Emulator provides all the signaling 
and communication protocols necessary to initiate and receive calls as well as evaluate 
the Frame Error Rate (FER) performance of the mobile station.  

Base Station
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CW 
Generators

SR5500

Mobile Station
Under Test

Rx/Tx
Σ

Base Station
Emulator

CW 
Generators

SR5500

Mobile Station
Under Test

Rx/Tx
Σ

 
Figure 1-3: C2K-ATS Test System 

The second configuration provides a direct connection from the Base Station Emulator to 
the Mobile Station under test, shown below. The spectrum analyzer is available to 
measure Mobile Station transmit signals. This configuration is particularly useful for 
Mobile Station transmitter tests. 

Base Station
Emulator

Power
Divider

Spectrum
Analyzer

Mobile Station
Under Test

Rx/Tx

 
Figure 1-4: Direct Configuration of Base Station Emulator and Mobile Station Under Test 

The third configuration utilizes the SR5500 to split the signal from the base station 
emulator into two independently impaired forward paths. These paths are connected to 
the primary and secondary receive antennae on the mobile station. The reverse path is 
unimpaired and is transmitted solely on the primary antenna connection. This 
configuration is used for Receiver Diversity tests. 
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Figure 1-5: C2K-ATS Receive Diversity Configuration 

1.3. Version History 

This version history highlights features and enhancements to C2K-ATS since the first 
version of the product. 

The following enhancements have been added in the 7.10 release of TASKIT C2K: 

• Added Support for C.S0011 Revision D. This includes new modulated interferers for 
Test cases 3.5.2 and 3.5.3. All supported test cases have been updated to conform 
to this new standard revision. In addition, new standard suites pertaining to the new 
revision of the specification have been created. 

• Added support for 10 MHz and 5 Mhz LTE Interferers. This is required by some carrier 
acceptance test plans. 

The following maintenance updates have been added in the 7.10 release of TASKIT/C2K: 

• The Idle handoff in non-slotted mode and idle handoff to different frequency test 
cases were not properly configuring the Air Access network emulator when Band 
Classes was greater than 9 were used. This has been corrected. 

• When range of open loop test cases on systems with SR8048 TCUs the user may 
encounter a level out of range error. This has been corrected. 

• Corrected an error handling issue with the following test cases:  

Access Probe output power test 

Range of open loop test 

Stand by and gated and output power test 

• Corrected an issue with Trial passwords. Software features were not properly being 
enabled with Trial passwords.  

• Corrected several bugs and limitations that were discovered with Simultaneous 
Voice/LTE Data Test cases including the following: 

 Corrected issues preventing the use of IPV6 for LTE Data connection 

 Made improvements to the Establishment, monitoring and maintenance of LTE 
Data Connections 
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 Corrected issues preventing full automation of LTE data connections when a UE 
uses a dial up networking interface on the client laptop.   

 Corrected an issue which prevented the user from changing the MCC and MNC 
parameters in the Mobile File. 

The following enhancements have been added in the 7.00 release of TASKIT C2K: 

• Added Support for new TCUs; SR8048 and SR8068. This allows you to perform 
CDMA2000 and LTE testing on the same Spirent system without re-cabling the 
instruments that are used across test themes. 

• Added support for a new SVLTE test case: 2.2.2 1xRTT Voice Call Reliability. 

• For SVLTE testing: Enhanced the stability of the LTE Data transfer.  
The code to monitor the LTE data transfer has been enhanced to better detect 
failures. In addition, a more efficient and reliable recover algorithm has been 
developed. 

The following maintenance enhancements have been added in the 7.00 release of 
TASKIT C2K: 

• For test cases sending a neighbor list message, it was discovered that the pilot_inc 
field was not being set according to the test standard. This issue has been resolved. 

The following enhancements have been added in the 6.00 release of TASKIT C2K: 

• Added the capability to perform CDMA 1xRTT testing with an LTE data call present. 

• Added support for Agilent 8960 Lab Application version C.01.12. 

• Added support for Agilent 8960 Test Application version B.17.08. 

• Added a new test parameter to the Conducted Spurious Emission test cases. This 
test parameter allows you to choose between "Sample" or "RMS" spectrum analyzer 
detector modes. 

• Added support for Band Class 10. 

• C2K-ATS can now run under Windows 7 in addition to Windows XP. 
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The following enhancements have been added in the 5.40 release of TASKIT C2K: 

• Added intermediate results for the Conducted Spurious Emissions test (C.S0011 test 
4.5.1). Intermediate Results are now displayed for the Spurious Emissions test in the 
Test Results panel. This gives you more visibility into steps performed during test 
execution. It will also allow you to see how the device under test is performing while 
the test is executing, rather than having to wait until the suite is complete.  

• Added Support for Air Access version 3.30. TASKIT C2K version 5.40 no longer 
support 2.x version of AirAccess. In addition the older AirAccess Instruments, namely 
SR3452 V1, TAS3450 and TAS5200 are no longer supported.  

• Added support for band class 10, 14 and 15. Band Class 10 is supported for 8960 
based test cases only. AirAccess does not support band class 10 so tests that use 
the AirAccess base station emulator cannot be run for Band Class 10. 

• Added a feature that allows Spirent to provide trial licenses to customers that want 
to evaluate the C2K-ATS product before purchasing it. Trial licenses can be issued for 
specific features, allowing a time limited evaluation of specific Test Packs or 
features. 

• The Session User Interface has been enhanced to allow you to view terminal files and 
suite files directly from the session grid. Clicking the session grid still launches a file 
menu that allows you to point to a terminal file or suite file. Pressing CTRL+click now 
displays the relevant suite file or terminal file.  

• A diagnostics debugging tool has been added to the TASKIT C2K installation. This 
tool is installed to the Utilities subfolder under the directory you installed the TASKIT 
C2K application to (default location is C:\Program Files\Taskit\C2K\Utilities). If the 
diagnostic procedure reports a failure, this tool instructs you through a set of 
measurements to determine the cause of the diagnostic failure.  
Typically, when a diagnostic failure occurs, TASKIT C2K software instructs you to 
confirm that cables are connected properly and each unit is powered on correctly. It 
does not offer any additional assistance if everything is cabled properly and powered 
on. The diagnostic debugging tool helps narrow down the exact cause of the failure 
even if it is something more complex than a cabling error.  

• TASKIT C2K has been modified to clearly indicate when there is a mismatch between 
the SR5500 instruments firmware and the API on the controller PC. Previous versions 
of TASKIT C2K software would only indicate that there was an API error but not 
indicate the cause of the error. Error handling has been enhanced to clearly indicate 
when a Firmware mismatch occurs. 

• Added e-mail notification feature for test execution events in TASKIT C2K. The TASKIT 
C2K software can be set to send a notification email when suit execution starts, 
when it ends, if a fatal error occurs or if a specified number of undetermined test 
results occur. Consult the User Manual for details concerning the use of this feature. 

• Added Intermediate results for the Maximum RF Output Power test (C.S0011 test 
4.4.5). Intermediate Results are now displayed for the max power test in the Test 
Results panel. This gives you more visibility into the test steps as they are executed. 
This is particularly useful for Supplemental channel tests where there are a number 
of measurements taken for each test case to determine the maximum output power 
test, while keeping the supplemental channel active.  
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• Added the ability to set power step size for C.S0011 test 4.4.5 Maximum RF Output 
Power Test. This is a user settable parameter. Standard test suites still default to 1 
dB, but can be modified to test smaller step sizes.  

• Added a parameter to IS 898 Test 3.4 Soft Handoff in Fading to allow you to specify 
the allowable error in Pilot Ec/Io. This was a hard coded value. TASKIT C2K previously 
would fail the test if the mobile did not issue a pilot strength measurement by the 
time the second pilot was above T_ADD by 2 dB. This is now a user-settable value. 
The default in the standard suites is still 2 dB.  

• Modified the channel over ride feature available in the suite grid. Previously, the 
override channel only applied to tests executing in connected state and would be 
ignored for other test cases performed without a data connection established. For 
example, idle handoff tests or access probe tests would ignore the override channel 
and instead execute on the channel number specified in the terminal file.  
Now, when an override channel is specified, it is used regardless of the test type. It is 
assumed that the channel is in the phones PRL for all non-connect state tests and all 
test cases that use the AirAccess network emulator 

• Increased the maximum number of tests allowed in a suite. Previously, the maximum 
number of rows was 255. The allowable number of rows has been doubled to 510. 

• Password protection of suits and sessions feature has been modified to no longer 
show a pop up window every time the TASKIT C2K software loads. Instead, you must 
go into software options to enable and disable this feature. When password 
protection is enabled, TASKIT C2K launches in read-only mode and anyone modifying 
suites has to disable this mode by entering the correct password in the software 
options menu. In addition, it was observed that in the rare event TASKIT C2K software 
crashed or Windows crashed after a new password was entered, it was not saved. 
The password protection feature has been modified to save the password as it is 
entered rather than when the software is closed. It is now saved regardless of how 
the software terminates.  

The following maintenance updates have been added in the 5.30 release of 
TASKIT/C2K: 

• Corrected an issue setting measurement averaging for the Maximum RF Output 
Power test (C.S0011 test 4.4.5) for supplemental channel test cases. The 8960 was 
not set correctly to enable multiple measurements. 

• For the "retry failed and undetermined test results" feature, the number of retries was 
not accurate when there was a mix of re-tests for undetermined and failed test 
results. This feature has been modified so that a single number of retries can be set. 
The TASKIT C2K software stops when the sum of failed and undetermined tests totals 
the set value. 

• C.S0011 test 4.4.5 Maximum RF Output Power Test was using the downlink 
frequency for retrieving the uplink and downlink calibration values. Because the RF 
path for this test varies slightly over frequency, the actual error in loss value was 
minimal for most band classes. For Band Class 5, uplink and downlink frequencies 
are further apart resulting in a detectable error in test performance. This error been 
corrected. 
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• Corrected an error where the last line of a session was not being saved. It was 
possible for a certain sequence of copying, pasting and creating lines in a session 
that the last line of the session would not get saved and would be blank upon re-
loading the session. This has been corrected. 

The following enhancements have been added in the 5.30 release of TASKIT C2K: 

• Added a rate of change measurement to C.S0011 test 4.3.1 Time Reference. TASKIT 
C2K had only been measuring the static case. The SR 5500 is used to introduce a 
delay of the forward path. This measures the ability of the mobile to synchronize that 
delay within the timing constraints in the testing standard 

• Added the ability to remotely control TASKIT C2K over a socket connection or through 
an API on the same PC. This allows you to run suites across different ATS products. In 
addition, you can use a scripting language to control additional test instruments or 
power supplies, and then run ATS tests as part of a larger test script. 

• Enhanced results reports allow you to clearly define what each test case is testing. 
For some test cases, it was difficult to determine by viewing the results report what 
standard the phone is being held to. This especially common for tests that do not 
include user-defined pass/fail limits. TASKIT C2K reports were enhanced to ensure 
that all tests clearly define the pass/fail criteria, as well as clearly report the failure 
reason for any tests that report a failed test result. 

• Added a feature to allow password protection of suite and session parameters. If this 
feature is enabled only a user that enters the password can edit suite and session 
settings for any of the files loaded into Test Drive EV-DO. This feature is useful when 
an advanced user wants to create suites and sessions to be run, but does not want 
other users to be able to change them.  

• Added the ability to perform margin testing for Frame Error Rate tests. TASKIT C2K 
now supports margin testing for Receiver Sensitivity, Single Tone Desensitization 
and Intermodulation Spurious Response. Margin testing characterizes the ability of 
the mobile to perform beyond the limit specified in the standards. In general, the 
impairment used in a given test is increased to determine how far beyond the level 
specified in the standard the mobile can still operate at or below the specified 
maximum frame error rate. 

• Added limit lines to the results report for Time Response of Open Loop Power Control 
tests (C.S0011 test 4.4.2). 

• Enhanced functionality related to automated testing using UTS driver. New functions 
were added to be compatible with new functions and properties in the UTS driver. In 
addition, when mobiles are characterized you can now select which features you 
want characterized. This allows you to skip characterizing features the mobile does 
not support. 

• Increased the allowable number of averages for C.S0011 test 4.5.1 Conducted 
Spurious Emissions. The maximum allowable averages were 50. This has been 
expanded to 200. 

• Added a feature to allow password protection of suite and session parameters. If this 
feature is enabled, you can only edit suite and session settings after entering a 
password. This feature is useful when an advanced user wants to create suites and 
sessions, but does not want others to edit them.  
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The following maintenance updates have been added in the 5.30 release of 
TASKIT/C2K: 

• Corrected an issue with Frame Error Rate tests minimum frames parameter. If a suite 
created before this parameter was available was loaded and saved, an error would 
occur when opened again. This issue has been corrected. 

• Expanded the acceptable calibration loss range for the path between the mobile and 
spectrum analyzer with Air Access. The existing range was not sufficient to 
accommodate the variation in component loss values and amplifier gain values 
across a wide range of TCU instruments. This could result in out-of-range errors 
displaying during the calibration procedure  

• Corrected an issue with Test 4.4.5: Maximum Output Power Test. Some mobiles 
displayed an issue for the supplemental channel case. The test specification 
instructs you lower the Ior until the mobile transmit stops rising, or the supplemental 
channel drops. Some mobiles would continue to increase the transmit power as the 
search algorithm reached very low Ior values. The low Ior would at times reach the 
sensitivity limit of the mobile. A new parameter has been added to this test to allow 
you to set “min Ior” when searching for the mobile’s maximum output power. If the 
min Ior value is reached, TASKIT C2K stops lowering Ior and considers the mobile 
transmit power at that Ior to be the maximum.  

• Corrected an issue with test C.S0011 test 4.5.1: Conducted Spurious Emissions. The 
absolute emissions sweep was incorrect for close-in spurs. Because the test 
specifies the “least stringent” of the absolute and relative sweeps, most mobiles 
pass this test by passing the relative sweeps, but observing the graphs showed an 
issue with the absolute sweeps. This has been corrected.  

The following enhancements have been added in the 5.20 release of TASKIT C2K: 

• TASKIT C2K now allows you to run Frame Error Rate tests using all up power control 
bits. It is suggested that this feature only be used for test that use a low Ior, 
otherwise the 8960 may have difficulty demodulating the mobile’s signal.  

• Added the ability to specify a Minimum Frame count for Frame Error Rate tests when 
confidence testing is turned on in the 8960. This feature is important when running 
fading tests to ensure the mobile is exposed to the full time varying fading profile 
before truncating the test due to the confidence requirement being met. 

• Added the ability to export results to PDF format. Note: this feature requires software 
package called PDF995 be installed on the PC. 

• Added the ability to generate test reports from different test types into a single PDF 
file. Note: this feature requires PDF995 PDF suite to be installed on the PC. 

• TestDrive EV-DO have been enhanced to provide an option automatically re-run tests 
that result in “Undetermined” and/or “Fail” status. The re-run will occur immediately 
following the failed or undetermined test status. You have the ability to select 
“Undetermined”, “Fail”, or that both be executed again. You can also configure the 
maximum number of times the software will automatically retry a test. 

• Added support for TIA-98-F specification. This feature did not add new test cases. All 
test cases that previously supported for the TIA-98-E standard have been modified to 
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also support the TIA-98-F standard. A new set of standard suites are included with 
TASKIT C2K to perform tests for the new standard.  

• TIA 98-E test 3.4.1 there were test cases that were listed as TBD in older versions of 
the standard. They have since been defined, so the test suites have been modified to 
include these tests.  

• TASKIT C2K now supports Service Option 68 for test cases that use Air Access as the 
network emulator. Note that this is a Voice Service option and should only be used 
for Stage 2 tests (IS 898) not TIA-98 standard tests. 

• TASKIT C2K now installs pre-defined test suites to test mobiles to the C.S0044 
standard. These test suites do not require their own password to run. Customers that 
have purchased the Stage 2 test suites do not need to purchase any additional test 
coverage in order to run these tests.  

• IS 898 Tests 8.1.1 – 8.1.5 MESSAGE_CT field is now set to 0 as a result of a customer 
request. The testing standard does not specify a value for this field so changing it 
does not violate the testing standard.  

• The slope calculation for TIA-98-E test 4.4.4 Range of Closed Loop Power Control has 
been modified to use averaging. This has resulted in more repeatable test results. 

• Added Support for Agilent 8960 E1962B Lab Application Revision B.12.21. 

• TIA-98-E Decision of Power Control tests 3.4.4 and 3.4.5 have been modified to 
setup the spectrum analyzer to more accurately capture the phone transmit traces. 
An algorithm was added to fine tune the reference level relative to the mobile’s 
transmit level, and a change to the Video Bandwidth has made the trace easier to 
analyze. These changes have resulted in more stable and repeatable test results. 

• An option that allows you to ignore extra probes when running the TIA 98E Access 
Probe Output Power test. Some mobiles re-dial when they do not get a response to a 
page.  
This may occur after sending probes of the proper sequence and power. To avoid 
having the redial cause a test failed test result the customer can enable this feature. 

• Added support for Band Class 15 (AWS Band) for all TIA-98-E, 8960 based test 
cases. Note: Air Access does not support this band class yet so test cases that 
require Air Access cannot be run for Band Class 15.  

• The Comm logging feature is modified to make it easier to retain log information. In 
previous versions of TASKIT C2K the software would over write the comm. log with 
the same named file every time a suite runs. Now the date and time is incorporated 
into the name of the Comm log so that it does not get over written and it is easy to 
find a log associated with a suite execution.  

Version 5.10 

The following enhancements have been added in the 5.10 release of TASKIT/C2K: 

• Added Support for the following 8960 Application versions: 

 E1962B cdma2000 Test Application Version: B.10.11 

 E6702B cdma2000 Lab Application Version: B.03.21 

• Added Support for AirAccess C2K Version 2.70. 
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• TASKIT/C2K now provides the capability to repeat TIA-98 AirAccess tests for multiple 
channel numbers. The multiple channel numbers can be specified in the mobile file, 
by setting the Include IS-98 AirAccess Tests in Test Channels field to Yes and 
using the Channel Number(s) for Test field to specify the channel number list. 
Unlike similar 8960 tests, TASKIT/C2K will set up the call on the same channel 
number, the test is being run on.  
Note: These channel numbers need to be present in the mobile’s PRL. 

• TIA-898 Tests 5.2.2.1, 5.2.2.2 and 5.2.2.3: Added flexibility to choose between 
Power Cycle or Reset for these tests, using a new Power Down Mode parameter in 
the mobile file. 

The following maintenance updates have been added in the 5.10 release of 
TASKIT/C2K: 

• BC5 channel numbers: Fixed an issue with TASKIT/C2K not allowing the use of 
channel numbers above 1199 for BC5 mobile. 

• Auto selection of BC3 channels for handoff tests: The algorithm for automatically 
choosing a BC3 channel for use during some handoff tests has been modified, to 
account for AirAccess limitations which eliminates the use of two channels that are 
too close to each other. 

• Diagnostics: The initial run of diagnostics run right after PLTS was used on the super 
rack, would always result in failure. This has been resolved. A couple of intermittent 
failure issues have also been addressed. 

• Security key: Missing TASKIT/C2K security key with the UDM security key present 
may cause the test executive to crash. This has been fixed. 

• TIA-98-D Test 3.1: This test could be run in the suite mode, but would fail in the 
session mode. This has been addressed. 

• TIA-98-E Test 3.4.4, 3.4.5: Corrected the power of F-FCH/Traffic to the correct level of 
-7.4 dB. 

• TIA-98-D Test 3.4.9: Sub-tests 9, 12, 13 and 16 were mislabeled as 1, 4, 5 and 8. The 
parameters were correct per the standard.  

• TIA-98-D Test 3.5.2: Fixed issue that might result in failure of test 3.5.2 if it is run 
right after test 3.4.9. 

• TIA-98-E Test 4.3.5: The test was looking at invalid code channels to determine 
pass/fail. It has been corrected to look only at code channels where both the Real (I) 
and Imaginary (Q) components are inactive. 

• TIA-98 Tests 3.4.1, 3.4.2, 3.5.1, 3.5.2 and 3.5.3: The pilot level settings for the Frame 
Error Rate tests can be set for a wider range of values, to match the allowable range 
in Agilent 8960. 

• TIA-898 Test 2.17: Resolved an issue with manual mode execution, where the test 
would fail indicating an issue with the second digit. 

• TIA-898 Tests 2.2 and 2.8: Resolved an issue where TASKIT/C2K would not correctly 
determine when the mobile enters system determination state. 

• TIA-898 Test 2.26: For Service Option 32768, when a Granted Mode of 0x1 had to be 
sent, a value of 0x0 was being sent. 
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• TIA-898 Test 3.7: Standard has an issue for the “without Return on Failure” scenario. 
It calls for the mobile to send a handoff completion message, even though the 
handoff is not going to occur. TASKIT/C2K no longer looks for this message. Instead, 
it just confirms that the mobile does not return. 

• TIA-898 Tests 5.2.2.2 and 5.7.2.1: Increased the registration wait time to account for 
the longer power cycle time of some mobiles. 

• TIA-898 Test 5.6.2.5: A pair of SID-NID values is used to test if the mobile can find 
proper service using both pairs and perform Parameter-Based Registration. In the 
case that the SID-NID pair is not present in mobile PRL, the mobile is unable to find 
service for that setup, failing the test. To resolve this issue: a) Prior to executing this 
test, a test PRL containing both SID-NID pairs will be loaded into the mobile; and b) 
At the end of the test, the original PRL will be restored. 

• TIA-898 Test 8.1.5: Removed voice mail notification component by setting 
MESSAGE_CT=0. 

• TIA-898 Test 8.3.1: To eliminate confusion during manual execution, renamed some 
parameter field names to match the field names used in UDM. Also, eliminated the 
need to enter the parameters, if the values required for the test match the values 
already stored in the mobile. 

• TIA-898 BC5/BC6 tests: Resolved issues with being unable to run some Chapter 7, 
14 and 15 tests for BC5/BC6 mobiles. 

• TIA-898 Test 6.4: Fixed an issue that could potentially generate a false passing 
result. A wait and a check for idle state was added after a failed registration 
authentication. This ensures that the mobile has returned to the channel before the 
origination attempt is made. 

• Fixed an issue launching help from windows other than the main window. All 
windows now launch the help properly. 

• Fixed an issue validating tests for Band Class 6. 

• Fixed a communication issue with the Spirent Activities Monitor that would 
intermittently cause lock-ups. 

• Fixed an issue with diagnostics in the diversity mode step. Unstable measurements 
will no longer occur. 

Version 5.00 

The following system changes have been added in the 5.00 release of TASKIT/C2K: 

• The 5.00 release supports a new System Architecture for running Receiver Diversity 
tests. New systems delivered going forward will no longer include the SR5058. The 
SR5058 has been replaced by the new SR5068 Test Configuration Unit. The SR5068 
works in conjunction with the TAS5048 to provide automated switching of RF signal 
paths for the various test cases supported by the TASKIT/C2K software.  
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The following TIA/EIA-98E based Rx Diversity tests have been added in the 5.00 
release of TASKIT/C2K: 

• 3.1 Demodulation of forward traffic channel in multi-path fading channel with closed 
loop power control FPC_MODE = ‘000’ 

• 3.3 Receiver sensitivity and dynamic range 

• 3.4 Single tone desensitization 

• 3.5 Intermodulation spurious response 

 



2. System Overview 

2.1. Overview 

The C2K Automatic Test System (C2K-ATS) provides an integrated test solution for 
evaluating third generation CDMA mobile units. By combining SR5500 Wireless Channel 
Emulator, CW Interference Emulator with a base station emulator and essential CDMA 
Test equipment, a turn-key test system is produced. TASKIT/C2K Windows software 
automates mobile testing by configuring the instruments, stepping through the test 
sequences, and logging the results.  

2.2. Guided Tour 

C2K-ATS combines powerful instruments and software into a comprehensible integrated 
test system. The major components of this system include: 

• TASKIT/C2K Automatic Test Executive 

• AirAccess C2K Network Emulation Software 

• Universal Diagnostic Monitor 

• SR5500 Wireless Channel Emulator 

• TAS5048 and SR5068 Test Configuration Units 

• SR3452 V2 CDMA Network Emulator Instruments (two) 

• Base Station Emulator (Agilent 8960) 

• CW Generators (Agilent E4438B) (two) 

• Spectrum Analyzer (Agilent E440xB ESA Series) 

• RF Control System (Agilent 3499A) 

2.2.1. TASKIT/C2K Automatic Test Executive 

TASKIT/C2K is a comprehensive automatic test solution for third generation CDMA 
mobile devices and is the core of TASKIT/C2K is a Windows-based software test 
executive that implements tests specified in key CDMA2000 test standards. With its 
open architecture, the software permits evaluation beyond minimum performance 
standards by allowing custom test scenarios to be created. 
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Figure 2-1: TASKIT/C2K Automatic Test Executive 

TASKIT/C2K is comprised of a powerful test executive, pre-defined test suites, 
instrument drivers, and custom development tools. The test software runs on PCs 
equipped with a National Instruments GPIB card and Microsoft Windows 2000 or 
Windows XP operating systems. TASKIT/C2K uses an Ethernet connection or the GPIB 
card port to communicate with the instruments in the system and the PC’s Serial or USB 
port to communicate with the mobile device under test. 

TASKIT/C2K simplifies test setup and conserves valuable resources by performing the 
following: 

• Mapping test parameters to instrument settings 

• Retrieving key information from the mobile device 

• Configuring instruments 

• Establishing calls between mobile device and base station emulator 

• Managing test information 

• Executing comprehensive automatic tests 

• Logging and reporting test results 

2.2.2. Universal Diagnostic Monitor 

The Universal Diagnostic Monitor is a powerful tool for monitoring the performance of a 
mobile device under test. UDM collects a variety of information from the mobile device 
and displays it in real-time. As a result, it is able to capture physical layer conditions 
reported by the mobile device over time. It also provides basic message logging, 
allowing you to see what air interface messages the mobile device is receiving. 
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Figure 2-2: Universal Diagnostic Monitor 

The UDM is able to interface with any mobile device. This is accomplished though mobile 
device drivers. Device drivers for mobile devices based on Qualcomm chipsets are 
provided. 

TASKIT/C2K uses the same interface to collect information from the mobile device, 
including ESN, software version, and the PRL (preferred roaming list). The PRL is decoded 
to determine the Band Classes, SID, and Channel Numbers in order to setup the mobile 
information correctly. 

2.2.3. Spirent SR5500 Wireless Channel Emulator 

The SR5500 RF Channel Emulator, as shown below, provides the ability to assess a 
CDMA mobile device’s capacity to mitigate multi-path effects by emulating the delay, 
fast and slow fading, and path loss characteristics of RF mobile communication 
channels.  
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Figure 2-3: SR5500 Wireless Channel Emulator 

A single SR5500 provides a superset of the requirements for CDMA testing. The SR5500 
emulates two independent wide bandwidth RF channels, each with up to twelve 
transmission paths. Delay, path loss, Rayleigh fading, and log-normal fading 
characteristics can be programmed for each path. When the AWGN option is enabled, 
Additive White Gaussian Noise can be added to both channels as well. Refer to the 
SR5500 Wireless Channel Emulator User Manual for further details about the features 
and operation of the instrument. 

2.2.4. TAS5048 and SR5068 Test Configuration Units 

The combination of the SR5068 and the TAS5048 Test Configuration Units automatically 
manages the switching of RF connections required for 3G mobile device testing. This 
allows the C2K-ATS to achieve the highest level of flexibility in test coverage. 

 
Figure 2-4: TAS5048 

Combined with the Agilent 3499B Logic/Control System, the TAS5048 can be 
automatically controlled with TASKIT/C2K software. Reconfiguring the CDMA signaling 
path in C2K-ATS is automatically handled by TASKIT/C2K. 
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Figure 2-5: TAS5048 and SR5068 Test Configuration Diagram 

2.2.5. SR8048 and SR8068 Test Configuration Units 

The SR8048 and SR8068 are a new generation of TCUs that support Spirent LTE 
Automated test systems in addition to CDMA2000 systems. From a functional 
standpoint, they provide all of the capabilities of the TAS5048 and SR5068 to maintain 
existing test coverage. They also allow you to perform LTE and CDMA2000 testing on the 
same system. Instruments such as the ESGs, Faders, and spectrum analyzers can be 
used across two wireless technologies providing a significant cost savings. Unlike the 
TAS5048 and SR6068, they not controlled using an Agilent 3499B. Instead they are 
connected to the router and controlled through an Ethernet connection. 

2.2.6. AirAccess C2K CDMA2000 Protocol Test System 

AirAccess C2K is a scalable CDMA protocol performance analysis solution for validating 
terminal messages and signaling conformance. The AirAccess system overcomes the 
limited call processing traditionally available in a one-box radio test set by introducing 
network level emulation. AirAccess’ advanced capabilities create a solution capable of 
verifying the latest mobile device features being developed in an evolving IS-2000 
network. AirAccess provides multiple sectors for true soft, softer and hard handoff 
emulation. 

C2K-ATS can automatically switch between the Base Station Emulator and AirAccess. 
This switch is determined by TASKIT/C2K automatically, without user intervention. 
AirAccess is comprised of two SR3452v2 CDMA Network Emulators.  
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Figure 2-6: Dual SR3452v2 CDMA Setup 

2.2.7. Base Station Emulator 

For most laboratory tests, using a Base Station Emulator instead of an actual base 
station provides a compact alternative with a standard remote control interface. The 
Base Station Emulator implements the CDMA air interface specifications for base 
stations. This includes functions such as mobile registration, mobile and base station-
initiated call connect and disconnect, call handoffs, and service option test modes. The 
Base Station Emulator also has built-in functions to verify the parametric performance of 
CDMA mobile stations.  

In addition to handling the CDMA test capabilities, most Base Station Emulators can also 
be equipped to perform comparable analog cellular transmitter and receiver tests. Refer 
to the Agilent 8960 documentation located at www.agilent.com for further details on the 
features and operation of this instrument.  

C2K-ATS supports the Agilent 8960 Base Station Emulator with the following 
configuration: 

• E5515C Test Set Mainframe 

• E1962B CDMA2000 Mobile Test Application or E6702B CDMA200 Mobile Lab 
Application 

• Option 003 Flexible CDMA Base Station Emulator 

• Option AX5 Rack flange kit with handles 
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2.2.8. Spectrum Analyzer 

The Spectrum Analyzer is used to perform system calibration, system diagnostics, and 
transmitter measurements of the mobile station. 

In C2K-ATS, the system routes the mobile transmitter to the spectrum analyzer. The 
spectrum analyzer is then used to perform CDMA200 transmitter tests as specified in TIA 
and 3GPP2 testing standards.  

TASKIT C2K supports the three spectrum analyzers shown below. They are listed along 
with the required instrument options. 

E44xxB ESA Series: 

• Option A4H – GPIB and Centronics Interfaces. 

• Option 120 – ACPR dynamic range extension. 

• Option 1CP – Rack mount and handle kit. 

E44xxB EXA Series: 

• Model must be N9010A-5xx, where xx=03, 07, 12, or 26 

 Option 120: 
Optional: 1CP (Rack mount kit with handles) 

E44xxB EXA Series: 

• Model must be N9020A-5xx, where xx=03, 07, 12, or 26 

 Option 120 
Optional: 1CP (Rack mount kit with handles) 

Refer to the Agilent Spectrum Analyzer User Manuals for details about the features and 
operation of these instruments. 

2.2.9. LTE Network Emulator 

An optional Spirent E2010S Broadband Networking Test Set adds the ability to perform 
CDMA 1xRTT RF testing with simultaneous LTE data transfers on LTE-capable 
smartphones. 

2.3. Installing C2K-ATS Software 

This section provides the details for installing the software in the C2K-ATS. The software 
included in the C2K-ATS includes UDM (Universal Diagnostic Monitor) and TASKIT/C2K 
Test Executive. 

If the AirAccess C2K Network Emulator is being used in the C2K-ATS, then the AirAccess 
C2K software must be installed on the same PC as the TASKIT/C2K software. Refer to the 
AirAccess C2K User Manual for more information on installing this software. 
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NOTE: TASKIT/C2K can interface directly with the mobile device through UDM to 
retrieve key device information. For this feature to operate, UDM must be installed 
on the PC. 

2.3.1. Universal Diagnostic Monitor 

NOTE: When installing UDM under Windows XP and Windows 2000 it is necessary to 
log onto the machine with administrative privileges. Using this log in ID when 
running UDM as part of the registry is unique to the particular User ID. 

UDM is distributed on CD only.  

To install UDM on your computer:  

1. Confirm that either Windows 2000 or Windows XP is the current operating system on 
your computer. 

2. Place the UDM CD in the CD-ROM drive.  
The install program should start automatically. If not, select Start Menu>Run and 
enter D:\SETUP in the text box and click OK (If your CD Drive is not D, substitute the 
appropriate drive letter). 

3. The Install program guides you through the rest of the installation process. 

4. If the setup program detects that certain system files must be updated to proceed, a 
message displays.  

a. To install the software on your computer, click OK and allow the setup program to 
update the system files.  

b. Setup prompts you to restart your computer.  
When Windows reboots, begin the installation process again. 

5. We recommend you use the default Installation Subdirectory and Program Folder. 

6.  Setup copies the necessary files. If you have already installed a previous version of 
UDM, you will be warned about replacing existing files. It is okay to replace the 
existing files. 

2.3.2. TASKIT/C2K Test Executive 

NOTE: When installing TASKIT/C2K under Windows XP and Windows 2000, it is 
necessary to log onto the machine with administrative privileges.  

TASKIT/C2K is distributed on CD only.  

To install the TASKIT/C2K Test Executive and Test Suites on your computer: 

1. Confirm that either Windows 7 or Windows XP is the current operating system on 
your computer. Also verify that National Instruments VISA Drivers Version 2.0 or later 
have been installed on your computer. 



24 | C2K-ATS User Manual 

2. If you currently have a previous version of TASKIT/C2K, you should uninstall it prior 
to installing this new version. Use the Add/Remove Programs feature located in the 
Control Panel to accomplish this. 

3. Place the TASKIT/C2K CD in the PC CD drive. The install program should start 
automatically. If not, select Run from Windows’ Start Menu, enter D:\SETUP in the 
text box and click OK (If your CD Drive is not D, substitute the appropriate drive 
letter).  

4. TASKIT/C2K Setup will configure Windows Installer on your computer if it is not 
currently setup. It may be necessary for setup to restart your computer in order for 
the configuration to take place. If you are prompted to restart the computer, click 
Restart.  
When Windows restarts, the setup automatically continues. If it does not continue, 
run the installation again, as described earlier. 

5. A Welcome window displays signifying the start of the installation process. Click 
Next to continue.  

6. The Spirent Software License Agreement displays.  
Read through it and select “I accept the terms in the license agreement”, and 
click Next. 

7. In the next window, you are prompted to enter your User Information, including your 
User Name and Organization. Complete the information and click Next. 

8. Select the destination folder where the TASKIT/C2K software will be installed. We 
recommend you use the default installation subdirectory. Click Next to continue. 

9. On the Setup Type window, select Complete Installation and click Next.  

10. TASKIT/C2K Setup is now ready to begin installing the software onto your computer. 
Click Install to begin this process. 

11. Once the installation process is complete, you may be asked to restart the computer 
for the changes to take effect. Click Yes to restart the computer. 

12. You may now begin using the TASKIT/C2K Test Executive software and Test Suites. 

2.3.3. C2K-ATS User and Reference Manual 

The C2K manuals are available on the CD. Use Windows Explorer to view the D:\Manuals 
folder (replace “D:” with the appropriate letter if your CD drive is not D). This folder 
contains a file called TASKIT_C2K_User_Manual.pdf, which is this manual. The folder 
also contains a file called TASKIT_C2K_Reference_Manual.pdf, which is a document 
containing test, parameter, and results descriptions. These manuals are also installed 
with TASKIT/C2K in a Manuals subfolder in the program directory. You can view and print 
these files using Adobe Acrobat Reader. If not already installed on the PC, a self-
extracting installation of Adobe Acrobat Reader can be found in the Adobe Acrobat Setup 
directory in the TASKIT folder. 
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2.3.4. Copy Protection 

To protect the software from being used illegally, UDM and TASKIT/C2K search for a 
hardware key before installation. Each product has its own hardware key shipped with 
each copy of the product. The hardware key connects to the PC parallel port. To connect 
both hardware keys at the same time, plug one hardware key into the PC parallel port, 
and then plug the second hardware key into the first hardware key. If you have a device 
already connected to the PC parallel port, follow these steps to install your hardware 
key: 

1. Disconnect the parallel device. 

2. Connect the hardware key(s) to your PC parallel port. 

3. Reconnect the parallel device to the hardware key. 

Multiple hardware keys can be connected to the same parallel port. Follow the 
instructions described above. 

If TASKIT/C2K or UDM does not detect the hardware key, certain software features will be 
unavailable. In TASKIT/C2K, if no hardware key is detected, a dialog box will appear 
indicating the problem when test execution is selected. Test execution will proceed, but 
the instruments will not be controlled. Instead, test execution will operate in a 
demonstration mode. In demonstration mode, the software will appear to be performing 
a test and collecting results. All test results simulated by the software. 

The UDM checks for the hardware key when it is executed. If it cannot find the hardware 
key, the program will notify you and close. 

NOTE: TASKIT/C2K also requires you enter a password.  
Refer to Section 3.22 for more information. 

2.4. Starting TASKIT/C2K 

To start TASKIT/C2K: 

1. Select Start>Programs>TASKIT.  

2. The following program icons display. 

Icon Description 

C2K  
TASKIT/C2K Program 

C2K Help  
TASKIT/C2K Help (also available from within TASKIT/C2K 
by selecting Contents from the Help menu) 

C2K Database Viewer  
C2K results database viewer program (also available from 
within TASKIT/C2K by selecting View Results from the 
Execute menu) 

C2K Notes  
Notes on TASKIT/C2K 
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3. Start TASKIT/C2K by clicking the C2K icon  shown in the TASKIT group.  
The TASKIT/C2K window displays, as shown in Figure 2-7. 

 
Figure 2-7: TASKIT/C2K Window 

2.5. Setting Communications Options for the PC 

Before communication between the PC and the instruments can take place, certain 
parameters must be defined using the Instrument Config command in the Config menu.  

 
Figure 2-8: TASKIT/C2K Window – Config Menu 
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2.6. Communication Settings 

Before using TASKIT/C2K, the National Instruments GPIB card should be installed and 
tested using procedures outlined in National Instrument’s user manual. Verify that all 
instruments are set for GPIB remote protocol. Refer to the individual instrument manuals 
for information on setting the remote protocol. To display the Communication window, 
select Instrument Config from the Config Menu. 

 
Figure 2-9: Instrument Settings Window – Communication Settings 

Each instrument must have the following parameters set properly: 

• Present – Check the checkbox next to the instrument name if it is connected to the 
system. Leave the instrument checkbox unchecked if it is not present. 

• GPIB Address – Set each instrument’s GPIB address to match the address that is set 
in the instrument. 

We recommend you use the Verify Hardware button to allow TASKIT/C2K to 
automatically verify the presence of the instruments and query the firmware version and 
hardware options of the instrument. TASKIT/C2K then looks for each enabled instrument 
at the selected GPIB Address. Click More Details to display detailed information about 
each instrument’s model, firmware version, and options. Click the Less Details button to 
hide this information. 
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Figure 2-10: Instrument Settings Window 

Click the OK button to store the instrument settings and return to the main window. Click 
the Cancel button to return to the main window without changing any instrument 
settings. 

2.7. Configuring the Mobile Settings 

To properly execute tests, TASKIT/C2K needs information about the mobile device. This 
information is stored in a mobile file with a .mob extension. Each time TASKIT/C2K is 
started, it attempts to load the previously used mobile file. The very first time 
TASKIT/C2K is started, it loads the default mobile file. 

The currently selected mobile file is displayed in the Current Mobile pull-down list on the 
toolbar. You can select a different mobile file from the pull-down list, by selecting Set 

Current Mobile from the Mobile menu, or by clicking on the  button next to the 
textbox. 
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Figure 2-11: Open Mobile File Window 

To view or edit the settings in the current mobile file, select View/Edit Mobile Settings 

in the Mobile menu, or click the  button next to the textbox. The Mobile Settings 
window displays, as shown in Figure 2-12. 

 
Figure 2-12: Mobile Settings Window 

We recommend you use the UDM feature to obtain the necessary settings directly from 
the mobile device. See section 4.2.3., Retrieving and Verifying Mobile Settings with 
UDM for more information on the UDM feature. 

When the settings are configured properly, click the Save button to save the changes in 
the mobile file. All the new settings overwrite the old settings in the file. To save the 
changes to a new file, click Save As. You can choose a new file to save the changes. 

NOTE: TASKIT/C2K does not allow you to save changes to the Default mobile file. 
TASKIT/C2K notifies you of this. Click OK and choose a new file name to save the 
changes. 
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Click the Cancel button to abandon all changes to the mobile settings. Refer to Section 
3.2 for detailed information on changing mobile settings. 

2.8. Loading a Pre-defined Test Suite 

Load a pre-defined Test Suite by selecting the Open Suite icon  from the toolbar or 
by selecting File>Open Suite. Open the 3.4.1 Demodulation of Forward Traffic 
Channel in the AWGN.STE suite of the Receiver Tests>TIA/EIA-98D directory, as shown 
in Figure 2-13. 

 
Figure 2-13: Open Suite File Window 

 
Figure 2-14: Open Suite File Window – Receiver Tests Folder 
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Figure 2-15: Open Suite File Window – Is-98d Folder 

The Initial Suite window is shown in Figure 2-16. 

 
Figure 2-16: Initial Suite Window 

The suite window is split between three viewing areas. In the left viewing area labeled 
Tests, all tests that will be run in the current suite are listed. The selected test is 
highlighted in yellow. Once the suite is running, the currently executing test is 
highlighted in green. The top-right viewing area labeled Test Settings shows test 
parameters for the selected test in the Tests window. The bottom-right viewing area 
labeled Test Results, shows the Validation Summary, Results Summary, or Error 
Summary. Refer to Section 3.3 for information on how to modify the suite and the 
individual test settings. 
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2.9. Running a Test Suite 

Run the Test Suite by selecting the Run icon  from the toolbar or by selecting 
Perform Test Suite from the Execute menu. The Execute Automatic Test window 
displays, allowing you to set several run-specific options. 

 
Figure 2-17: Execute Automatic Test Window 

2.10. Test Result Options 

The Execute Automatic Test dialog box prompts you for the location of the Results Path 
to store the Database File which stores all test parameters and results. TASKIT/C2K uses 
a Microsoft Access database format with the .mdb file extension. The Database File 
Options determines whether the database is cleared before adding any results.  
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2.11. Run Specific Information 

The Run Specific Information window allows you to enter a description of the Vendor, 
Device Under Test, and Run. This information is associated with the parameters and 
results of a specific test. This information can be used to retrieve information from the 
database at a later time. The specific Band Class(es), Radio Configuration(s), and 
Channel Number(s) that the test performs on are also identified. 

2.12. UDM Logging Options 

The UDM Logging Options allow you to view a wealth of information about the mobile’s 
state and over the air message processing that is recorded in conjunction with 
TASKIT/C2K test information. You must install the Spirent Communications Universal 
Diagnostic Monitor (UDM) on the PC in order for UDM logging to be active. UDM logging 
can be disabled or enabled only for tests that do not generate passing results, or 
enabled for all tests. If enabled, you must specify a UDM workspace file. A workspace file 
is created from the UDM application, and is saved with a .udm file extension. The 
workspace file controls what mobile data is logged during the course of a test. Enable or 
disable the Features by bringing up the logging window in UDM and clicking on the 
Filters button in the UDM logging window. Refer to the UDM documentation for more 
information on how to set up logging filters. In many instances, the default.udm 
workspace that ships with UDM should be adequate. During test execution, UDM logs 
are stored in folders designated by session or suite name and time stamp. They are 
stored under a root folder in the Results Path labeled <database name> UDM Logs. 

NOTE: Select Clear this folder then add results to this folder in the Test Result 
Options menu to clear out all UDM log files and folders under the <database name> 
UDM Logs folder. Do not put any other files in any of these directories as they will be 
lost when the database is cleared. 

2.13. Mobile Automation 

TASKIT/C2K is designed to support full automation of all tests. To achieve full 
automation the mobile must be controlled and instructed to perform a variety of 
functions such as answer calls, place calls, and set parameters. This is done though an 
interface to the Spirent Universal Diagnostic Monitor (UDM). A fully functional device 
driver for a given mobile should be capable of full automation of all tests. These device 
drivers are created by the mobile manufacturer for a specific model phone. In the event 
that a device driver does not exist for a specific mobile, Spirent has included some 
generic device drivers that are capable of automating a majority of mobile functions for 
many phones. Device drivers need to be characterized for each mobile used in 
TASKIT/C2K. Refer to Section 3.2.4 for information on characterizing mobile devices for a 
specific device driver.  
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In the event that a mobile function is not supported in a particular phone or device 
driver, or if UDM is not installed, user-assistance may be required for some tests. Suites 
and sessions are analyzed prior to running to see if any user-assistance is required in 
any tests. Tests that require user assistance are listed in the User-Assistance pane. 
Checking the option to skip user-assisted test will run only those tests running with full 
automation. Any tests in the suite requiring user-assistance will be performed first. A 
status bar displays indicating how many tests require user-assistance. This feature 
allows you to know when to leave the system for unattended execution.  

By default, test execution starts with test #1 and proceeds through the suite in 
ascending order of test number. You can select specific tests to run by clicking on the 
test number in the left hand column. When the test number is clicked it turns green. In 
this case only the selected test numbers run in ascending order. If you have entered 
more than one Radio Configuration and more than one Test Channel in the mobile file, 
the TASKIT/C2K repeats the first test for each Radio Configuration on the first channel. 
Then it repeats the first test for each Radio Configuration on the second channel. 
However, only the tests in which the mobile device matches the “applies to” settings are 
run.  

2.14. Switching Between Views 

The Validation Summary, Results Summary, and Errors Summary views can be switched 

at any time prior to or during test execution by clicking the appropriate button . 
Validation occurs prior to test execution, so the Validation summary view is not updated 
during test execution. The Results summary and Errors summary are both updated in 
real-time during test execution. 

The Validate Summary button  configures the bottom-right window to display 
validation messages. Validation messages are displayed if you validate the suite, or if 
the Always validate suites before execution checkbox is checked in the Software 
menu. 
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Figure 2-18: Suite Window – Validation Summary 

The Results Summary button  configures the bottom-right viewing area to display test 
results. Test results display in real-time, with the current test results appearing on the 
last line of the grid. If the scrollbar is positioned at the bottom, the results grid auto-
scroll as tests are completed. If the scrollbar is moved from the bottom position, auto-
scroll is disabled. This allows viewing of results for a particular test during execution. If a 
test status is Pass, the device passed the test. If the test status is Fail, the test 
completed on the device, but the device does not meet or exceed the minimum passing 
criteria. If the test status is Undt, the test could not be performed due to test execution 
errors. 

 
Figure 2-19: Suite Window – Results Summary 
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The Errors Summary button  configures the bottom-right viewing area to display test 
errors. Test errors are also displayed in real-time, with the current test error appearing on 
the last line of the grid. 

In the upper right frame where Test Settings are shown, there are three icons used to 

switch views. The  icon is used only for Spurious Emissions Tests. Clicking on this 
icon displays a table of Frequency Sweep Segments. This table is used to specify 
frequency ranges and maximum levels to be used for spurious emissions sweeps. The 

 icon is used to view the test details setting. When a test is selected on the left hand 

grid the test settings are displayed on the right. The  icon is used to view the 
intermediate results. Clicking this icon while a suite is running displays detailed 
information about every test step. 

2.15. User Assistance 

Some tests may require user assistance to be performed. Any tests in the suite requiring 
user assistance are performed first. As shown in the following figures, a status bar 
displays, indicating how many tests require user assistance. This feature allows you to 
know when you can leave the system. 

 
Figure 2-20: User Assisted Test Message 
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Figure 2-21: Automated Test Display 

2.16. Halting Test Execution 

TASKIT/C2K provides three means of halting test execution. Selecting the Cancel Test 

button , or selecting Cancel Test from the Execute Menu cancels the current test 

only. Selecting the Cancel Suite button , or selecting Cancel Suite from the Execute 

Menu cancels execution of the entire suite. Selecting the Pause button  or selecting 
Pause Execution from the Execute Menu pauses the current test. When the test is 

paused, the button changes to the Continue button , and the menu item changes to 
Continue Execution either of which resumes the test execution. These buttons are 
found on the toolbar of the main window. 

2.17. Viewing Test Results 

After the Test Suite has been run, the results can be viewed. View the results by selecting 

the View Results icon  from the toolbar or the Analyze Test Results under the 
Execute menu to start the TASKIT/C2K Database Viewer Application.  

The TASKIT/C2K Database Viewer allows you to view the results stored in the Microsoft 
Access database file you selected in the Execute Automatic Test window. Refer to 
Section 3.10 for a detailed explanation of how to use this application. 
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Figure 2-22: Viewing Test Results 

2.18. Generating a Report 

To generate a report, click the  button or select Selected Field Report from the 
Reports menu. The following screen shows the report window. Click the Print button to 
print the report to the default printer. Refer to Section 3.17 for more information on 
generating various types of reports. 

 
Figure 2-23: Report Preview Window 



3. Advanced Features 

3.1. Overview 

This chapter is designed to introduce you to the more advanced features of TASKIT/C2K. 
The items covered in this section are: 

• Editing a Mobile File 

• Editing a Test Suite 

• System Calibration 

• Software Options 

• Validating a Test Suite 

• Working with Sessions 

• TASKIT/C2K Database Viewer 

• Report Types 

A pre-defined Test Suite from one of the standard TIA/EIA-98D Receiver Tests illustrates 
the advanced features of TASKIT/C2K. Start TASKIT/C2K and verify that the PC 
communications options and the hardware setups for the instruments are correctly 
configured. After you have configured the instruments, load the following Test Suite: 

Receiver Tests/TIA/EIA-98D/3.4.1 Demodulation of Forward Traffic Channel in AWGN.STE  

3.2. Editing a Mobile File 

TASKIT/C2K uses a Mobile File for storage and retrieval of mobile specific parameters. 
These parameters are necessary to ensure proper execution of each test in a suite. When 
a suite is executed, the mobile parameters are read from the current mobile file. To 
choose a different mobile file, select Set Current Mobile from the Mobile menu, or 

select a Mobile from the Current Mobile pull-down list. You can aolsoclick on the  
button on the right side of the toolbar and select the Mobile File from the dialog box. 

To edit the current mobile parameters, select View>Edit Mobile Settings from the 

Mobile menu, or click the  button on the toolbar. The Mobile window opens as shown 
below. 
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Figure 3-1: Default MOB Window 

The current Mobile File being used is indicated in the window’s title bar. Make 
adjustments to the settings in this window for the Mobile in use. When you are finished, 
click on the Save button to save the new settings in the Mobile File. If you want to save 
your settings to a different Mobile File, click on the Save As button. Click Cancel to 
abandon any changes. 

NOTE: TASKIT/C2K does not allow you to save changes to the Default mobile file. If 
you attempt to do this, TASKIT/C2K indicates the problem. Click OK and choose a new 
file name to save the changes. 

When TASKIT/C2K is closed, it keeps track of the last mobile file used. Next time it is 
started, it loads that same mobile file as the current mobile file. 

3.2.1. Setting Mobile Parameters 

Mobile parameters can be edited in the same manner as test parameters. Parameters 
with a numeric range allow any value in range to be entered. Parameters that can only be 
set to a specific set of values allow only these values to be selected from a drop-down 
control. Refer to the C2K-ATS Reference Manual for more details about these parameter 
settings. 
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3.2.2. Loss Settings 

The Loss Settings grid is provided so that the loss from the isolation chamber to the 
mobile’s antenna port can be characterized. The Primary Antenna Loss grid displays the 
loss values from the end of cable C2 to the mobile’s primary antenna port. The 
Secondary Antenna Loss grid displays the loss values from the end of cable C24 to the 
mobile’s secondary antenna port. Secondary antenna loss is only used by receiver 
diversity tests. To achieve the highest degree of accuracy possible, this loss should be 
measured at several frequencies and entered into the grid. If the test system does not 
include any Spirent instruments (Channel Emulator, Noise Emulator or TCU) then the loss 
settings should include all cables/connectors between the Base Station and the Mobile 
Station.  

3.2.3. Retrieving and Verifying Mobile Settings with UDM 

The Universal Diagnostic Monitor (UDM) is an additional tool for TASKIT/C2K. If the UDM 
is installed on the control PC, some mobile settings can be retrieved directly from the 
mobile via serial connection. The mobile settings that the UDM can retrieve are: 

• Channel Number and Channel Number for Test 

• Band Class 

• ESN 

• NID 

• SID 

• Current NAM 

TASKIT/C2K requires that the Mobile Manufacturer, Mobile Model, Mobile Port, Mobile 
Port Speed, and Service Programming Code parameters be properly assigned prior to 
using UDM to update mobile settings. See the UDM manual for information on installing 
UDM and manufacturer DLLs. 

To retrieve or verify mobile settings: 

1. Select a Mobile Manufacturer. 

2. Select a Mobile Model. 

3. Select a Mobile Port. 

4. Select a Mobile Port Speed. 

5. Enter the Service Programming Code for the mobile. 

6. If required, enter the Connection AT Command. 

7. Enter the AT Command Data Rate. 
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Prior to clicking the Update Mobile or Verify Settings buttons, you must set the Current 
NAM parameter. This parameter tells TASKIT/C2K which NAM to search for the PRL data 
in. You can manually select Current NAM, or you can retrieve it automatically via UDM by 
clicking the Query Current NAM button. 

Click the Update Mobile button to retrieve mobile settings via UDM. TASKIT/C2K 
attempts to communicate with the mobile device via UDM. If it is unsuccessful, it 
attempts to communicate at different bit rates. If TASKIT is unsuccessful at all bit rates 
you are notified of the problem.  

If more than one call setup channel is found in the PRL, TASKIT/C2K identifies this 
condition. You are be prompted to select a band class and then a channel number. When 
you have made your selection, click OK. TASKIT/C2K uses your selection to update the 
mobile file information. 

The current settings can also be verified by clicking on the Verify Settings button. 
TASKIT/C2K attempts to communicate with the mobile device via UDM. TASKIT/C2K then 
checks the current mobile parameters against all PRL entries for the current NAM. 

NOTE: The Current NAM parameter is also used in many CDG Stage II tests. 
TASKIT/C2K will set any NV Parameters required for each test in the current NAM 
only. 

3.2.4. Characterizing Mobile Automation Capabilities 

In order to best arrange test suite execution order, TASKIT/C2K needs information on the 
automation capabilities of the mobile under test with the selected device driver. 
TASKIT/C2K analyzes each test in a suite based on its automation capabilities for all 
mobile functions used in the test. Tests are then classified as either fully automated or 
requiring user assistance. Tests requiring user assistance are always executed first so 
the remaining tests can be run unattended. 

NOTE: It is strongly recommended that all mobile automation capabilities be 
characterized to ensure an execution order that is most convenient for you. 
TASKIT/C2K allows the option to run with an uncharacterized mobile, but all tests 
that require mobile automation are classified as requiring user assistance when they 
may in fact not. This may result in TASKIT/C2K prompting you for assistance at 
various times during a suite as opposed to all in the beginning. 

Click the Mobile Automation button in the mobile window to bring up the mobile 
automation window. This window displays the device driver selected for the current 
mobile, whether or not it is characterized, and a list of mobile automation features. All 
mobile automation features used in TASKIT/C2K are listed in this window. If a particular 
automation feature is supported, then a ‘Yes’ displays in the Supported column for that 
feature. If a particular feature is not supported, a ‘No’ displays in the Supported column 
and a reason for lack of support is listed. The figure below shows the mobile automation 
window. 
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Figure 3-2: Mobile Automation Characterization Window 

Click the Characterize Mobile button to begin characterization of the mobile 
automation features. A progress indicator shows the feature that is currently being 
checked. When complete, click the Accept Changes button and then Close to return to 
the mobile window. Be sure to save the mobile file again, as mobile automation data is 
saved in the mobile file. Characterization can take up to 10 minutes, but need only be 
done once per mobile. 

NOTE: Changing Manufacturer or Model in the mobile file clears the mobile 
automation information. Using Save As to create another mobile file also preserves 
characterization information, so if creating a new mobile file for a new device, be 
sure to run characterization again. 
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3.3. Editing a Test Suite 

The TASKIT/C2K window, after loading the Test Suite is shown in Figure 3-3. 

 
Figure 3-3: Test Suite Window 

3.3.1. Adding a Test 

Each test in a suite can be one of several different test types. Different tests are used to 
measure different performance criteria. A unique set of parameters applies to each test 
type. Each test type and their associated parameters are described in detail later in this 
chapter. 

When adding a new test, use the following steps to select a test type: 

1. Click on a blank cell in the Test Title column of the suite window to select it. 

2. Click on the blank cell again to show the Test Types menu. 

3. Select the desired test type from the menus. 

NOTE: Once you have selected a test type for a particular test you cannot change it. 
You can delete the test to make the cell blank and then use the steps above to create 
a new test. 

The parameters of each Test File can be edited in the Test Settings window in the upper-
right pane of the suite window. The Test Settings window lists the available parameters 
for the selected test in the Tests pane. The test selected in the test pane is highlighted in 
blue. 
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Figure 3-4: Test Settings Window – Fields 

The fields in the Test Settings window are divided into several groups of related 
parameters. Each of these groups has parameter fields that may be edited before the 
test is executed. The parameter labels are based directly on those found in the TIA/EIA-
98D/E test standards. The method of editing each parameter depends on its field type. 
There are two basic field types: Text box fields, and List box fields. Text box fields apply 
to parameters whose values are within a specific range, usually numeric. List box fields 
apply to parameters whose values are restricted to a specific set. 

To edit a parameter, click once on the desired parameter value to select it. Click once 
more to edit the parameter. Depending on the parameter type, a value can be entered 
directly, or a value can be selected from a list of valid values. 

Clicking on a parameter contained in a text box field highlights the current value. A new 
value can now be entered. Click Enter to accept the new value. If the new value is out of 
range, TASKIT/C2K resets the old value and displays the valid range. 

 
Figure 3-5: Test Settings – Parameter Values 
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To view all available parameter values, click on a parameter contained in a list box. Click 
the desired value to set the parameter to the new value. 

 
Figure 3-6: Setting New Parameter Value 

3.3.2. Group Edit 

If you want to set a parameter to the same value in more than one test, you can use the 
Group Edit feature. Group Edit allows you to set the same values for multiple tests 
without editing each test individually. For example, you may want to set Ior to –90 for 
tests 1 through 20. Group Edit makes this easy and convenient. 

TASKIT/C2K allows you to select more than one test at a time. To do this, click and hold 
the mouse on the first test you wish to select in the Test grid. Then drag the mouse 
pointer to the last test that you wish to select. You can accomplish the same selection by 
using the shift key. Click on the first test of the group you wish to select. Hold down the 
shift key and click on the last test in the group. 

Similarly, you can select tests by holding down the control key and clicking on the 
individual tests you wish to edit. The tests selected do not necessarily need to be in a 
contiguous block when selections are made in this manner. 

Once you have your group of tests selected, you can make changes to the test 
parameters. If a parameter setting is blank, it means that it is different across the tests in 
the group. If you set a parameter, it will affect that parameter in every test in the group to 
the value you enter. Some parameters may not apply to every test selected. In this case, 
the parameter setting will only apply to those tests that support that parameter. 

3.3.3. Parameter Sweep 

If you find it necessary to execute a test repeatedly while a parameter is slowly changed 
for each repetition, you can use the Parameter Sweep feature. For example, if you want 
to repeatedly execute an FER test while Ioc is adjusted incrementally for each test. 
Parameter Sweep simplifies this task. It builds a suite of tests very quickly based on your 
criteria. 
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To use this feature, it is best to start with a new suite. Add a new test as Test 1. Select 
the test type you want to perform. Modify the test parameters accordingly. When you are 
finished, click on the parameter you wish to increase or decrease. You may only select 
one parameter. 

With the parameter you wish to vary selected, select Sweep from the Edit menu, or click 
on the broom icon. The Sweep window displays. Enter the start, stop, and increment 
values appropriately. TASKIT/C2K indicates the legal range for the parameter and 
calculates the number of tests to be added to the suite. 

You can choose to have the Description for each test appended with the parameter 
sweep information. This is useful when analyzing the results later. When you click OK, 
TASKIT/C2K adds the calculated number of tests to the suite. The parameters across all 
tests are identical except the parameter to be swept. Its value changes for each test 
appropriately. 

3.3.4. Override Channels 

The third column on the suite form has the heading Override Channels. Typically, you 
specify the channels that all tests in a suite are run on by editing channel numbers for 
test in the Mobile file. Specifying channels in this way requires that all tests within a 
suite are run for the same set of channels. If you need to run certain tests on a given set 
of channel numbers and other tests on different channels, the Override Channels 
parameter allows you to do this. You can enter channels in this column separated by a 
comma or dash. If this column is left blank for a given test the software uses the 
channels specified in the mobile file. This field is not applicable for tests that are not run 
in traffic state.  

3.4. System Calibration 

TASKIT/C2K includes an automated calibration procedure to achieve high accuracy for 
power levels at various points in the system. When TASKIT/C2K is executed for the first 
time, default calibration data is loaded into memory. This data is available until you run 
the calibration procedure for the first time. We recommend that you execute the 
calibration procedure when the system is first installed, and once every six months 
thereafter.  

To ensure the accuracy of the measurements taken during system calibration it is 
suggested that the spectrum analyzer calibration procedure be run prior to running 
system calibration. If the system has an ESA spectrum analyzer, run the calibration 
procedure outlined in the Agilent ESA Spectrum Analyzers User’s Guide. If you are 
using an 8590 series spectrum analyzer, run the calibration procedure outlined in the 
Agilent 8590 E-Series and L-Series Spectrum Analyzer’s User’s Guide.” 
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To execute the System Calibration procedure, select System Calibration from the 
Execute menu. This launches the TASKIT/C2K Calibration Wizard (see below). During the 
calibration procedure, it is necessary for an operator to re-configure some of the RF 
cables. The entire procedure should require approximately 5 to 45 minutes, depending 
on the instruments in the system. 

 
Figure 3-7: Calibration Wizard Window 

3.4.1. Performing a Calibration 

The following hardware is required in order to run calibration: 

• Agilent 8960 or AirAccess – provides a signal source. AirAccess will only be used by 
the calibration routine if an 8960 is not present in the system. 

• Agilent 859XE or ESA-series spectrum analyzer – used to take all power 
measurements. 

• Agilent 3499, TAS5048 and SR5068 – configures various system signal paths. 

• Various RF cables as provided in the TCU kit. 

• N-type female-female connector provided in the TCU kit. 

• A 50 ohm termination provided in the TCU kit. 

• 13/16” Torque Wrench, 9/16” open end wrench 

To perform a system calibration: 

1. Configure the RF cables as specified by the instructions displayed in the dialog box. 
Make sure to use the proper cables for each step of the procedure. Each cable 
should be clearly labeled with a tag (e.g. cable #1 is labeled C1, etc). 

2. Click the Next button to initiate measurements. The Progress Bar displays the text 
Calibrating indicating that the procedure is executing. 
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3. When the calibration step is complete, a new diagram displays. When the Progress 
Bar displays the text Waiting For User, move on to the next step. 

When the calibration procedure is completed, the following message box displays. 

 
Figure 3-8: Successful Calibration Window 

This indicates that the new calibration data has been verified and is saved to the system 
registry for future use. It is necessary to re-cable the system as indicated in the C2K-ATS 
Setup Guide. We recommend that you execute the System Calibration procedure prior to 
executing any new tests. For more information, refer to Section 3.4. 

3.5. Software Options 

To set the Software Options, select Options>Software. This screen contains fields that 
allow you to save your preferences for the Default File Location, User Name, User Initials, 
and Company Name.  

Comm Log Type can be set to None, Fail-Safe, or Fast. Setting this to a value other than 
None creates a record of all instrument transactions in a file. For fastest execution, set 
this parameter to None. Setting this parameter to Fail-Safe writes to the comm. log after 
each transaction. This is the slowest method, but it ensures that all commands are 
recorded in the event of a failure. Setting this parameter to Fast writes to the comm. log 
in bursts. This speeds up execution at the cost of losing some instrument transactions in 
the event of a failure. The comm. log file is called CDMACOMM.LOG and is located in 
the same directory as the current database file. 

Selecting the first check box tells TASKIT/C2K to always run in demo mode. Demo mode 
does not send commands to the instruments, and is a simulation of TASKIT/C2K 
execution.  

Selecting the second check box tells TASKIT/C2K to automatically validate suites prior to 
execution. Validation errors cause the suite execution to halt. Validating ensures test 
parameters are valid. 

Selecting the third checkbox allows you to hide the path information for file names that 
are displayed in grids throughout the software. 

The User-Assistance Message Box Timeout tells TASKIT/C2K how long to wait for user-
assistance for a feature that requires it. If the timeout expires before you acknowledge 
the action, an error is logged and execution moves on to the next test. Setting a value of 
zero disables the timeout and wait indefinitely. 
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You can choose to automatically control the mobile through UDM. If UDM is not 
installed, this option should not be selected. If you are performing SVLTE tests with a UE 
that supports AT commands, select this option. If you cannot use UDM or AT commands, 
disable mobile automation. 

The Auto-Retry options allow you to selectively re-run any tests that fail or otherwise 
achieve an undetermined status ( due to faulty instrument configuration, or unexpected 
errors with the mobile, etc.). Any test that fails or achieves “undetermined” status, is re-
run immediately for a fixed number of times as specified in the options dialog. 

 
Figure 3-9: Software Options Window 

3.6. Validating a Test Suite 

Before running a Test Suite, it should be validated to help avoid test execution errors. 
TASKIT/C2K analyzes an entire suite for test setup and parameter value problems before 
execution. Validation checks test conditions against the current system configuration 
and alerts you if the system does not contain sufficient hardware to perform certain 
tests. Although this does not guarantee flawless execution, it significantly reduces the 
risk of problems during execution by detecting them beforehand.  

To validate the Test Suite select the Validate Suite icon  from the Tool Bar, or select 
Execute>Validate Suite. 
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In the example shown below, errors were found. After Validating the Suite, view all 
validation messages by clicking the Check button in the bottom-right pane of the suite 
window. 

 
Figure 3-10: Viewing Validation Messages 

3.7. Working with Sessions 

A Session is a group of suites. Create a new session by selecting New Session from the 

File menu, or clicking on the  button. The new session window is shown below.  

 
Figure 3-11: New Session Window 
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A Session allows you to collect related Suites into one group and run them one after the 
other. To insert a Suite into the Session grid, double-click on a cell in the Suite File 
column. This action recalls a dialog box that allows you to select a suite file. In the 
following example, suites from the receiver tests\TIA-EIA-98-D directory are being 
opened into the session. 

 
Figure 3-12: Open Suite File Window 

When a Suite is opened into a Session, a description of the Suite is read from the file 
and displayed in the Suite Description column. You cannot directly edit the Suite or its 
description from the Session, you can only do so through the suite window. To edit the 
Suite or its description, hold the Control key and double-click on the Suite file in the 
Session Grid. Changes made to the Suite must be saved before they are accepted by the 
Session. 

You can adjust the width of the columns in the session by dragging the column 
separator. This allows you to view long file names in the grid. 

 
Figure 3-13: Session Window – Selecting Mobile File 
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A Mobile File must be specified for each Suite within the Session by double-clicking on 
the cell in the Mobile File column. This recalls a dialog which allows you to select a 
mobile file (*.mob) as shown below. The Mobile File can be viewed in a window by 
holding in the Control key and double-clicking on the file in the Mobile File column in 
the Session grid. 

 
Figure 3-14: Open Mobile File Window 

A mobile file must be specified for each line in a session or TASKIT/C2K does not allow 
you to execute the session. 

 
Figure 3-15: Session Window 

The Session grid supports group cut, copy, paste, and delete operations except for the 
Suite Description column. You cannot modify this column directly because it is paired 
with the Suite File. When you cut, copy, paste, or delete a Suite, the description is paired 
with it. 
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Any Suite files or Mobile files that have errors, such as file not found, display in red in 
the grid. The error message is displayed in the Description. You have the option of re-
specifying the file or deleting it. 

WARNING: The Session file contains the file paths and names of all the Suite and 
Mobile files it contains. If you move or rename any of the Suite and/or Mobile files 
pointed to by the Session, the Session cannot find them. If this happens, you need to 
re-specify all the moved/renamed files in the Session. 

Save a Session by clicking on the  button or selecting Save from the File menu. 

Session files have the extension *.csn. Open Session files by clicking on the  button 
or selecting Open Session from the File menu. 

3.8. Validating and Running a Session 

Validate a Session by clicking the  button, or selecting Execute>Validate Test 
Session. Session validation may take a few minutes because it must load each Suite 
from disk, and then run a validation on each Suite. 

Once the Session has been created, you can run the session by clicking on the  
button or selecting Perform Test Session from the Execute menu. First, each suite in the 
session is loaded along with the corresponding mobile file and analyzed for user-
assisted tests. The Execute Automatic Test window displays. This window allows you to 
select the location of the database and whether you want to overwrite or append to the 
database. 
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h  
Figure 3-16: Execute Automatic Test Window 

The Execute Automatic Test window, shown in Figure 3-16, contains the same session 
information as for a suite. Refer to Section 2.9 for a description of the features found in 
the Execute Automatic Test window. 

The Run Specific Information allows you to enter a description of the Vendor, Device 
under Test, and Run. This information is associated with the parameters and results of a 
specific test. This information can be used to retrieve information from the database at a 
later time. The specific Band Class(es), Radio Configuration(s) and Channel Number(s) 
that the test is performed on are also identified. 

Execute the Session from this window by clicking on the Run button. The Session loads 
the first Suite and proceeds to execute one suite at a time in ascending order. Once a 
suite completes running, it is removed from memory and the next suite is loaded and 
executed. The lower half of the Session window contains three views: Validation 
Summary, Results Summary, and Errors Summary. These summaries are updated at 
various stages of Session execution. 

The Validation Summary, Results Summary, and Errors Summary views can be switched 
at any time prior to or during test execution by clicking on the appropriate button . 
Validation occurs prior to test execution, so the Validation summary view will not be 
updated during test execution. The Results summary and Errors summary are both 
updated in real-time during test execution. 
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3.9. Controlling Session Execution 

The button group on the toolbar of the main window,  controls the 

execution of the Session. The Pause button,  pauses the currently executing test. 

This button toggles to Resume , which resumes test execution when clicked. The 

Stop button  stops the currently executing test, and begins executing the very next 

test in the current suite. The Cancel Suite button  cancels the currently executing 
suite and begins executing the next suite in the session. The Cancel Session button 

 cancels the session entirely. 

3.10. CDMA Database Viewer 

The CDMA Database Viewer is a stand-alone application that allows you to retrieve, view, 
and print test results. The CDMA Database Viewer can be accessed from TASKIT/C2K by 

clicking on the View Results icon  or by starting it from the Windows Start menu. The 
CDMA Database Viewer window is shown in Figure 3-17. 

 
Figure 3-17: Database Viewer Window 

To open a database, select File>Open, or click the  button in the toolbar. Select the 
database file from the File window. 
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Figure 3-18: Open Database File Window 

TASKIT/C2K stores test results in a Microsoft Access databasewith the file extension 
.mdb. The following image shows the database opened in the CDMA Database Viewer 
application. 

 
Figure 3-19: TASKIT/C2K Database Viewer 
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3.11. Database Viewer Toolbars 

The following list describes the Database Viewer toolbars. The top toolbar contains 
buttons which duplicate many of the menu items. The bottom toolbar is for restricting 
the data to common items of interest. 

 Open Database File 

Opens a database file. 

 Copy Data to Windows Clipboard 

Copies all data to the Windows clipboard. This is useful for pasting the data into another 
application, such as a spreadsheet. 

 Save to Spreadsheet Compatible File 

Saves all data to a spreadsheet compatible file. The file is saved as tab-delimited text 
with an “.xls” extension. This file can be opened into Microsoft Excel. 

 Report on Selected Fields 

Generates a print preview window of the data. The Print Preview window can then be 
sent to the printer. 

 Report on All Parameters and Results 

This generates a report on all test details and results of all the tests shown in the 
database grid. 

Report on Test Errors 

This generates a report on all errors that occurred for all the tests shown in the database 
grid. 

 Suite and Session Statistics 

Generates a report that summarizes the total run time of each suite or session ( and the 
suites contained within) that are available in the database. This helps a user to get an 
insight into the usage of the system for specific tests. 

PDF viewer  

 Generates the report for the selected test in PDF format. ( Please note that this 
button gets enabled only when PDF995 software is detected on the host system ) 
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Multi-test Report viewer 

This utility allows you to choose multiple tests (based on the test type, e.g., packet error 
tests, code domain output power tests, etc.) and combine them to create a single report. 
Note that this utility can be used only when the PDF suite from Software995 is installed 
on the host system. When you use this utility, a window displays similar to the one 
shown in Figure 3-20. 

 
Figure 3-20: Available Tests Window 

The contents of the window depend on the database that you use. This utility parses the 
database and collects information regarding the various types of tests available. You can 
select the different test type by checking the appropriate boxes. You can also choose to 
have any combination of “passed”, “failed”, and “undetermined” tests in the final report 
by selecting those options. You can also specify the output file name (use complete 
path). Finally, generate the report by clicking the Generate Report button. 

 View UDM Log File 

This opens the UDM Log File associated with the selected test. 

  Modify Fields 

Recalls the Field Selection window. This window allows the columns shown in the 
database grid to be modified. Data fields can be added or removed through this window. 

  Stop Data 

Stops access to the database. In the event that data retrieval is taking a long amount of 
time, this button will stop the process. This allows the data to be restricted so that a 
fewer number of records are retrieved from the database. 

  Help 

Launches the Help application. 
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 View Test Types List 

Restricts the data to a given test type. When “All” is selected, there is no test type 
restriction. 

 View ESN(s) List 

Restricts the data to a given mobile ESN. All ESNs stored in the database are retrieved 
and put into this list. When “All” is selected, there is no ESN restriction. 

 View Tests that Passed 

Restricts the data to tests that passed. Un-checking this checkbox will remove all 
“passed” tests from the database grid. 

 View Tests that Failed 

Restricts the data to tests that failed. Un-checking this checkbox will remove all “failed” 
tests from the database grid. 

 View Tests that were Undetermined 

Restricts the data to tests that were undetermined. Un-checking this checkbox will 
remove all “undetermined” tests from the database grid. 

The status bar at the bottom of the main window updates periodically to give information 
as to what operations are being performed. The total number of test records retrieved 
from the database is displayed when the database access operation is complete. 

3.12. Field Selection Window 

The Field Selection window, shown in Figure 3-21, is used to include or exclude 
individual data fields from being shown in the database grid. 

 
Figure 3-21: Field Selection Window – Common Fields Tab 
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Data fields are separated by whether they are common to all tests, or unique to one or 
more (but not all) tests. The Field Selection window has a Folder tab that allows you to 
view the Common or Unique Fields. 

To include common fields in the database grid, select the row in the “Available Fields” 
grid. The selected row is highlighted in red as shown in Figure 3-22. Then, click the Add 
button and the field will be added to the end of the “Displayed Fields” grid. 

If a field is selected in the “Displayed Fields” grid, the Add button becomes the Insert 
button. Clicking the Insert button will insert the field from the “Available Fields” by 
creating a new row in the “Displayed Fields” grid just before the highlighted row. 

To remove a field from the database grid, click on the row in the “Displayed Fields” grid 
and click the Remove button. The field will be removed from the “Displayed Fields” grid 
and added to the end of the “Available Fields” grid. 

The Field Selection window with the “Unique Fields” folder tab selected is shown in 
Figure 3-22. 

 
Figure 3-22: Field Selection Window – Unique Fields Tab 

The Unique Fields folder tab works exactly the same way as the Common Fields tab, 
except that the test type must be selected from the pull-down list. Since unique fields 
are unique to a specific test, the test must be selected before the fields are shown. 

3.13. Common and Unique Fields 

Common fields are data fields that are common to all test types. For example, the 
Description field is a common field because all reports have a description. Unique fields 
are data fields that are included in one or more (but not all) test types. For example, 
TargetFER is a field that is unique to the FER Characterization test. 
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Common fields always display in the left columns in the database grid in the order that 
they are selected in the “Displayed Fields” grid. Once the common fields are displayed in 
the grid, the unique fields display in the remaining columns on the right of the window. 

The Sort Order for common fields can be specified in the “Displayed Fields” grid by 
selecting the order number from the pull down list in the grid. Tests will be sorted 
according to the field but within a given test type. For example, sorting by 
ResTimeStampStart will sort the tests within a given test type to the order in which they 
began executing. Sorting can only be done by common fields. 

3.14. Report Restrictions 

Access the less commonly used report restrictions by selecting Options>Report 
Restrictions. The Report Restrictions window displays, as shown in Figure 3-23. 

The common restrictions (Test Type, ESN, Passed, Failed, and Undetermined) are 
contained on the toolbar.  

 
Figure 3-23: Report Restrictions Window 

This window allows you to restrict the data to relevant Vendor, Device Description, 
Execution Description, Suite Number(s), and/or Date(s). Check the checkbox next to the 
desired restriction, and choose the specific item from the list to achieve the restriction. 
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3.15. Software Options 

Select further options in the Software Options window, shown in Figure 3-24, by 
selecting Options>Software Options.  

 
Figure 3-24: Software Options Window 

The Disable “Mobile” section in Details Reports option hides the mobile section in the 
details reports. The mobile section can be repetitive if the same mobile is used over a 
large number of tests. 

The Disable Headers in main grid option hides the gray column headers in the 
database grid. 

The PDF995 Install Dir option is necessary when you want to use utilities such as the 
PDF viewer of the Multi-test Report viewer. 

3.16. Customizing Reports with a Company Name and Logo 

Reports can be customized by embedding a logo bitmap and company name in the 
database. The logo bitmap will appear in the upper left corner of each page in a report, 
and the company name will appear in the lower left corner of each page in a report. To 
select a logo, click the Open button and use the file dialog box to choose a “.bmp” file. 
The ideal logo bitmap is 96 pixels in width by 48 pixels in height. Bitmaps larger or 
smaller than 48x96 will be resized. To remove a logo from the database, click the 
Remove button. Click OK to store the options in the database. Click Cancel to abandon 
any changes to the database. 

3.17. Report Types 

There are three types of reporting tools available in the CDMA Database Viewer: Selected 

Fields Report, , All Parameters and Results Report, , and Test Errors Report .  
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3.18. Report Type Selection Window 

When viewing “All” test types in the CDMA Database Viewer window, you can generate 
the All Parameters and Results report, but you must select the specific report type. Figure 
3-25 below shows the Report Type Selection window. After selecting the report type from 
the list, click OK to generate the report. 

 
Figure 3-25: Report Type Selection Window 

3.19. Selected Fields Report 

The Selected Fields report provides information on the fields you have selected: one field 
per column, one test per row.  

 
Figure 3-26: Report Print Preview Window 
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The column widths of the database grid determine the column widths of this report. 
There are times when the number of columns causes the data to spill completely across 
the page and on to another page. When this happens, the “Page X of X” label will 
become “Page X,Y of X,Y.” Where X is the vertical page number and Y is the horizontal 
page number. 

Click the > button to advance to the next page. Click the < button to go back to the 
previous page. Click the Print button to print the pages to the Windows default printer. 
Click the Close button to close the report. 

3.20. All Parameters and Results Report 

The All Parameters and Results report displays all the test parameters and results for a 
given test. One or more report pages are devoted to each test. Figure 3-27 shows an 
example of the first page of the printed report. 

 
Figure 3-27: Parameters and Results Window 

3.21. Single Page Report 

By selecting a single line in the main grid you can generate a report on that test. The 
image shown below shows the CDMA Database Viewer main screen with a line selected. 
Clicking on the All Parameters and Results Report button will generate a report for that 
single test. This is useful for recalling the details of a failed test, as shown. 

Clicking on the line a second time will unselect it. If no single test is selected, clicking on 
the All Parameters and Results Report button generates the report for all the tests in 
the main grid. 
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Figure 3-28: Database Viewer Window – Test Report 

All reports that are generated are displayed on the PC screen. Control icons for the 
displayed report are described below in the order that they appear at the top of the 
display. 

 Move to page 1 of the report. 

 Move to the previous page of the report. 

1 of 1 Current page number of the total number of pages. 

 Stop the generation of the report. 

 Move to the next page of the report. 

 Move to the last page of the report. 

 Print the report. 

 Export the report to a file in a format such as Excel or MS Word. 

 Select the size of the page displayed. 

Total: 36 Number of tests that meet the search criteria. 

100% Amount of report that has completed loading. 

36 of 36 Number of tests that meet the search criteria of total number of test in the 
database. 
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3.22. Security Features 

TASKIT/C2K uses a security mechanism that controls access to specific software 
functionality. This mechanism includes attaching a hardware key to the TASKIT/C2K 
Controller PC and entering a password within the TASKIT/C2K application software. Refer 
to Section 2.3.4 for details. 

3.23. Entering a Password 

A unique password is needed to unlock specific software functionality in TASKIT/C2K. 
After installing TASKIT/C2K for the first time – or when unlocking new software 
functionality – this unique password must be entered into the software application. To 
enter the password into TASKIT/C2K, click the Help menu and select Enter Password. 
Enter the provided password into the text box and click OK. 

 
Figure 3-29: Password Window 

3.24. C2K API 

The API (Application Programming Interface) feature of TASKIT/C2K provides remote 
control of the basic features of the application. This enables users to develop their own 
software around the standard TASKIT/C2K test executive.  

NOTE: A sample project developed in Visual Basic 6.0 is installed with TASKIT/C2K 
(e.g. C:\Program Files\Taskit\C2K\API Sample\). This project provides an example of 
how to use the API feature of the application. 

The TASKIT/C2K API is deployed as a COM Dynamic Link Library (DLL). This library 
(C2KRemote.DLL) in installed with TASKIT/C2K. The interface to this DLL exposes a single 
public class (C2KAPI) that contains the properties, methods, and events outlined below. 

Once an instance of the C2KAPI class has been created, the TASKIT/C2K test executive 
will automatically open. This will allow for the ability to view the progress of tests while 
they are being run. While TASKIT/C2K is being controlled through the API, it will be in 
remote mode, where most of the functionality will be disabled. However, a limited set of 
features shall remain available in remote mode, such as the ability to halt or pause tests. 
TASKIT/C2K is returned to local mode (full functionality) once the C2KAPI object has 
been released. 
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3.25. API Properties 

3.25.1. CurrentMobile 

Data Type:  String 

Default Value: Last set mobile file in TASKIT/C2K test executive 

Description: This property corresponds to the location of the current mobile file that will 
be used to run a suite of tests in TASKIT/C2K. This is the remote equivalent of selecting 
‘Current Mobile’ on the right side of the toolbar in the TASKIT/C2K user interface. When 
this property is not set remotely, it will maintain the location of the last current mobile 
file set. 

3.25.2. DatabaseLocation 

Data Type:  String 

Default Value: Location of results database of last test that was run 

Description: This property corresponds to the location of the TASKIT/C2K results 
database. This is the remote equivalent of setting the location of the database when a 
suite file is to be executed. When this property is not set remotely, it will maintain the 
location of the last database file used. 

3.25.3. AppendToDatabase 

Data Type:  Boolean 

Default Value: Last setting used in TASKIT/C2K 

Description: This property can be used to specify whether the results of the tests to be 
run will be appended to the currently selected database or whether the currently 
selected database will be cleared when the next test is run. When this property is not set 
remotely, it will maintain the last setting used. 
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3.26. API Methods 

3.26.1. RunSuite 

Inputs: SuitePath – a string that specifies the location of the suite file to be run 

Outputs: None 

Description: This method will load and execute the suite file specified as input. It will use 
the mobile file determined by the CurrentMobile property and will log the results to the 
database determined by the DatabaseLocation property. When this method is executed, 
it will act as a blocking function and will hold control until the suite has completed 
executing or an error has occurred. The API will provide updates of the current status of 
the running suite through the ProgressUpdate event (see below). Since the TASKIT/C2K 
test executive is running in the background, the progress of the running suite can also be 
viewed or halted by switching over to the application. 

3.26.2. StopExecution 

Inputs: None 

Outputs: None 

Description: This method will halt any currently executing suites. Since the RunSuite 
method acts as blocking function, this method can be called while handing the 
ProgressUpdate event to stop execution of the suite. 

3.27. API Events 

3.27.1. SuiteComplete 

Outputs: None 

Description: This event will be fired by TASKIT/C2K whenever execution of a suite has 
completed. After this event is fired, you can run more suites, or analyze results from the 
completed suite execution. 
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3.27.2. ProgressUpdate 

Outputs: Status – a string representing the current action being performed by the 
TASKIT/C2K test executive 

Description: The TASKIT/C2K software will fire this event frequently during the execution 
of a suite of tests. It provides information of the current execution steps being performed 
by the software. 

3.27.3. Error 

Outputs: Error Message – A string describing the error. 

Description: The TASKIT/C2K software will fire this event when an error occurs in the 
course of the suite execution. Non-critical errors result in the software continuing to the 
next test in the suite.  

If a critical error results in the termination of suite execution, the SuiteComplete event is 
also fired.  



4. Simultaneous Voice/LTE Data Testing 

4.1. Overview 

With the addition of the TSKT-STG1-SVLTE-TP1 option, C2K-ATS can perform CDMA2000 
1xRTT RF tests while an LTE data transfer is active. 

4.2. Configuring C2K-ATS for SVLTE Testing 

To configure C2K-ATS for SVLTE testing: 

1. Connect the UE to the test equipment as shown in the UE Antenna Configuration 
Setup Guide. 

2. In the Instrument Configuration window, shown in Figure 4-1, select the E2010 LTE 
Emulator option and (if necessary) the Directional Coupler option. 

  
Figure 4-1: Instrument Configuration Window 

3. If you have not already done so, perform system calibration. 
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4. In the mobile file for the device to be tested, enable the "SVLTE" option. Select the 
antenna configuration used. Refer to the SVLTE Setup Guide to determine the 
external hardware configuration that matches the UE antenna configuration. Set the 
LTE parameters, including authentication parameters, to the desired values. 
Configure UE Automation in the mobile file as well. 

 
Figure 4-2: Editing the Mobile File 

5. If the UE to be tested supports automation via AT commands, enable UE automation 
in the Software Options window, You cannot use UDM automation when for SVLTE 
testing. 
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Figure 4-3: Software Options Window 

6. For SVLTE testing, the UE should be connected to the client laptop, not the system 
controller PC, as it is for 1xRTT-only testing. 

After completing these steps, configure and run the test suite as described in Chapter 2 
and Chapter 3 of this manual.



5. Multi-Application Remote API 

5.1. Overview 

The TestDrive Remote Client is a utility used to control TASKIT C2K, TestDrive EV-DO, and 
TASKIT PLTS systems at the same time. The Client window is shown in Figure 5-1. The 
Client allows you to configure the different applications and configure long-running 
automated sessions.  

The utility manages all overhead tasks when switching from one system to another. For 
example, when switching from a C2K test suite to an EV-DO suite, the utility 
automatically switches the base station application to EV-DO, the mobile to EV-DO-only 
mode, and sets the appropriate terminal file, database, etc. Without this utility, you 
would have to monitor the C2K system to finish execution, and manually perform these 
actions before executing the EV-DO system. 

 
Figure 5-1: TestDrive Remote Client Window 
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5.2. Requirements 

• VB .NET module on the controller PC. This utility was developed on the .NET 
framework and requires a .NET module on the host system. When the application is 
executed, it checks for this module and prompts for installation, if needed. 

• Spirent Super-Rack; or a Spirent system capable of executing C2K, PLTS, and EV-DO 
test suites.  
This system normally consists of: Agilent 8960, 3460/3462, 3452, 5500, TCU, 
Agilent 3499, Agilent Spectrum Analyzer, and TAS 3710 PDE, GSS 5060/6560.  
The host PC should contain the latest versions of applications that support this 
utility. Software versions prior to C2K 5.30, EV-DO 4.30 and PLTS 3.10 do not offer 
support. 

• The mobile device driver needs to support functionality to switch the device between 
CDMA service only, EV-DO service only and Hybrid modes (CDMA or EV-DO). 

5.3. Features and General Usage 

1. Start the Server. The Command window displays, as shown in Figure 5-2. 

 
Figure 5-2: Server Initialization Window 

2. Start the Client.  
The TestDrive Data Client window displays, as shown in Figure 5-1. 

3. Connect the client to the server by clicking the Connect button.  
After connecting to the server, the utility reads an initialization file (MSF.ini)  
You are notified if there is a problem with initialization  

NOTE: Using the default INI file is not mandatory. We recommend you go through 
the initialization procedure when using the software for and after any upgrades to 
the Agilent 8960. 

4. Add a suite by clicking the Add Suite button.  
The utility reads the suite prompts for the appropriate device file (.mob for C2K, .ter 
for EV-DO and .mob for PLTS ). 
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NOTE: The PLTS device file is different from the C2K mobile file, even though they 
have the same extension (.mob).  

5. As suites are added, they are grouped according to the application.  
Change the order of execution by clicking the Application header in the Suite 
window.  

6. Update the Result databases for the appropriate applications. 

7. Save the Session settings by clicking the Save Session File button.  

8. Validate or execute the session.  
Validation is recommended to verify the Application Settings (instrument 
configuration, software settings), and Device File Settings (especially the Com Port 
setting) are correct.  

9. Verify the settings by clicking the Configuration button. 
The System Configuration window displays, as shown in Figure 5-3. 

 
Figure 5-3: System Configuration Window 

10. The System Configuration window allows you to configure and verify individual 
application settings.  
For example, to verify C2K settings, click the Start button next to C2K application, 
disable Remote Mode, and configure the C2K settings using the TASKIT C2K GUI.  

NOTE: When you load a Device file in the utility, only the path is noted. The file 
contents can still be changed. 

11. When changing from C2K to EV-DO, you must set the base station to the appropriate 
application.  

12. Select the application using the Agilent 8960 settings in the System Configuration 
window, as shown in Figure 5-3.  
You must start either C2K or EV-DO before the 8960 displays the available 
applications. 

13. Click the Query Device button to query the 8960.  
Available C2K and EV-DO choices are populated and you can set the preferred 
application.  
This step is necessary after upgrading the 8960, or using a different system.  
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These settings are stored in the MSF.ini file and loaded automatically when the 
application is started. 

14. After completing System Configuration, proceed to executing the session.  

NOTE: The system will stop and prompt for user-assisted tests and system failures. 

5.4. Email Notification 

5.4.1. Overview 

This feature enables automated email notification. The Email Notification allows you to 
receive emails about events occurring in C2K. To set Email Notifications, select 
Config>Email Notification. The Email Notification window displays, as shown in Figure 
5-4. 

 
Figure 5-4: Email Notification Window 

You can set the following parameters in the Email Notification window: 

• Enable Email Notification 
This parameter allows you to enable or disable email notification. By default, email 
notification is disabled.  

• Email To 
This parameter allows you to specify an email address. Separate multiple email 
addresses with semi-colons. 
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• Maximum number of emails to send 
This parameter limits the number of emails sent for a given run of C2K. While running 
a session, C2K resets this parameter at the session level. When running a suite, C2K 
resets this parameter at the suite level. 

• C2K Starts 
Sends an email when C2K starts. With this option, Email Notification needs to be 
enabled. 

• C2K Stops 
Sends an email when C2K stops. With this option, Email Notification needs to be 
enabled. 

• Fatal Errors 
Sends an email when there are fatal errors. These include failure to connect to 
instruments, mobile failed to register, and failure to connect to UDM. With this 
option, Email Notification needs to be enabled. 

• Number of Undetermined Exceeds 
Sends an email when the number of undetermined test results exceeds the specified 
limit. With this option, Email Notification needs to be enabled. 

5.4.2. Requirements 

You are required to configure the IIS SMTP Virtual Server on the machine running 
TestDrive C2K.  

To configure the IIS SMTP Virtual Server: 

1. Select Start>Control Panel. 

2. Under Administrative Tools, open Internet Information Services. 

3. Under the left pane in the Internet Information Services window, right-click Default 
SMTP Virtual Server and select Properties. 

4. The Default SMTP Virtual Server Properties window displays.  
Select the Delivery tab and click Outbound Security. 

5. Under Outbound Security, select Integrated Windows Authentication, enter a valid 
username and password and click OK.  

6. Under the Delivery tab, click the Advanced button.  

7. The Advanced Delivery Options window displays.  

a. Enter the name of your email server for Smart Host and click OK.  

b. To use the IP Address instead of the server name, enter it in square brackets “[ ]” 
to tell Windows to look for an IP Address during the DNS Look-up.  
Note that DNS Look-up is an expensive operation. 

8. Under the Delivery tab, click the Apply button, and then click OK. 

9. The SMTP Virtual Server Configuration is now complete.  

 



6. Troubleshooting C2K-ATS 

6.1. Overview 

The following section should be used as a reference guide for troubleshooting problems 
with test execution. The FAQs are also available on the Spirent Communications, 
Wireless Division Web Site URL: http://www.taskit.com/customer.htm  

C2K-ATS was designed to make testing 3G CDMA mobile devices as simple as possible. 
However, as with any complex system, it is possible to encounter difficulty when using 
C2K-ATS. This section provides useful information to troubleshoot such difficulty. 

C2K-ATS has a diagnostic utility built into the TASKIT/C2K software. This feature can 
evaluate the current RF cabling to determine if the system has been cabled correctly. It 
will also determine if the instruments can be controlled via GPIB. There is additional 
information in this chapter regarding errors that occur while validating and executing a 
test suite. 

Although a test suite may execute properly, the actual results may look incorrect. A 
separate section of this chapter addresses such unexpected results. Finally, a list of 
frequently asked questions (FAQs) and their associated answers can be found at the end 
of this chapter. 

6.2. System Diagnostics 

The TASKIT/C2K System Diagnostic procedure is a useful tool for debugging system level 
problems such as incorrect software configuration, incorrect control or RF cable 
configuration, and malfunctioning equipment. This procedure is not intended to perform 
calibration of any system hardware. If you suspect that any of your Spirent hardware 
needs to be calibrated, refer to the User Manual for the specific instrument. 

The following instruments must be installed in the system to execute this procedure: 

• Agilent 8960 

• Agilent ESA series Spectrum Analyzer 

• Agilent 3499, TAS5408 and SR5068 Test Configuration Unit 

• GPIB and RF cables includes in TCU-KIT. 

Additionally the following optional equipment will be tested if they are connected to your 
system: 

• Spirent Wireless Channel Emulator 

• ESG4438B Signal Generator 
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Prior to executing this procedure it is required to configure the entire system as outlined 
in sections 2.4 through 2.6. To execute the diagnostic procedure, select ‘System 
Diagnostics’ from the ‘Execute’ menu. Then click the ‘Run’ button. The following is a 
sample of information that will be displayed while the diagnostic procedure is executing: 

 
Figure 6-1: C2K-ATS Diagnostic Procedure Window 

The following steps describe the functions performed when the System Diagnostic 
procedure is executed. If errors are detected while the procedure is executed, the 
software will display a list of possible causes in a message box. Additionally, these 
descriptions are documented below for convenience. 

Step 0 – Initializing HW 

This procedure attempts to communicate with all required system hardware. If 
TASKIT/C2K software or any control cables are incorrectly configured, it will be detected 
by this test. If this test fails, the following are the most likely causes: 

• Required instrument HW is not enabled. Check the ‘Communications’ settings from 
the ‘Software’ menu. 

• Incorrect GPIB addresses have been selected. Verify that ‘Communications’ setting in 
the ‘Software’ menu match the instrument configurations. Each instrument should 
have a unique GPIB address.  

• GPIB cables have not been properly connected to one or more instruments. 

• One or more instruments have not been powered on. 

• GPIB card has not been installed/configured correctly in the test PC. 

Steps 1 and 2 – Checking 8960 

This procedure verifies the RF generator in the Agilent 8960 and the measurement 
capability of the Spectrum Analyzer. Additional it verifies that the Agilent 3499, TAS5048 
and SR5068 are working, and that some of the RF cables have been correctly configured. 
If this test fails, the following are the most likely causes: 
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• Power has not been applied to the TAS5048 or SR5068. This can be verified by 
checking the green status LED on the front panel. 

• The custom control cable is not securely connected from the Agilent 3499 to the 
TAS5048. 

• Cable C3 is not securely connected from the Agilent 8960 RF IN/OUT port to the 
TAS5048 P3 port. 

• Cable C1 is not securely connected from the Spectrum Analyzer RF IN port to the 
TAS5048 P1 port. 

Additionally it is possible that one of the following instruments is malfunctioning: 
Agilent 8960, Agilent 3499, TAS5048, SR5068 or Agilent Spectrum Analyzer. 

Step 3 – Checking the Channel Emulator Auto Range 

This procedure verifies the SR5500 is receiving a signal at the appropriate level and can 
perform an auto-range function. If this test fails, the following are the most likely causes: 

• Cable C5 is not securely connected from the SR5500 Channel #1 IN port to the 
TAS5048 P5 port. 

Additionally it is possible that one of the following instruments is malfunctioning:  

TAS5048, SR5068 and Agilent 3499A. 

Step 4 – Checking Channel Emulator Output Level 

This procedure verifies the SR5500 Channel #1 main signal path is operational. If this 
test fails, the following are the most likely causes: 

• Cable C10 is not securely connected from the SR5500 Channel #1 OUT port to the 
SR5068 P3 port. 

• There is no loopback cable connected from the SR5500 Channel #1 LO OUT to 
Channel #1 LO IN. 

Step 5 – Checking Channel Emulator Bypass Level 

This procedure verifies the SR5500 Channel #1 Bypass feature is working properly. If this 
test fails, the following are the most likely causes: 

• SR5500 may be operating out of spec. 

Steps 6 and 7 – Checking ESG #1 Output Amplitude and Frequency 

This procedure verifies that the ESG #1 is working properly. If this test fails, the following 
are the most likely causes: 

• Cable C7 is not securely connected to the 1U filler Panel P2 port. 

• Cable C22 is not securely connected to the SR5068 P11 port 
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Steps 8 and 9 – Checking ESG #2 Output Amplitude and Frequency 

This procedure verifies that the ESG #2 is working properly. If this test fails, the following 
are the most likely causes: 

• Cable C8 is not securely connected to the 1U filler Panel P1 port. 

• Cable C21 is not securely connected to the SR5068 P13 port 

6.3. Diagnostic Debugger 

The Diagnostic Debugger supports both C2K-ATS and EV-DO TestDrive systems, up to the 
latest release. If any step after Initialization fails, start the Diagnostics Debugger by 
opening the C2K_Diag_Debug.exe file. During the process, leave the C2K and/or EV-DO 
Executive windows open. 

An “N-type” female-female connector and a torque wrench are needed to change cable 
connections. 

After opening the C2K_Diag_Debug.exe file, the Diagnostic Debugger window displays, 
as shown in Figure 6-2.  

 
Figure 6-2: Diagnostics Debugger Window 
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The following sections of the Diagnostics Debugger window are the most relevant for 
debugging a failed diagnostic process: 

• Instruction Pane –This pane is located in the upper section of the window.  
The pane allows you to set Instrument Parameters, Re-cable Connections, and set 
measurements.  
The settings prior to debugging are shown in the Instruction Pane when the debugger 
starts. 

• Debug Steps – This menu displays in the upper-right corner of the window.  
Select the diagnostic step that failed from the pull-down menu to view the steps. 

• Connect Button – This button is in the upper-left section of the window. Before 
debugging, the Diagnostics Debugger must be connected to the system. 

• Switch Position Panels –These two panels are located in the lower-left section of 
the window.  
There are eight (8) switches for SR5048 and six (6) switches for SR5068. Set the two 
positions of each switch by clicking the Position One or Position Two button. 

• SR5048 Configuration and SR5068 Configuration – These menus are located 
under the Instruction Panel.  
Select the standard paths determined by the switches of the SR5048 and SR5068 
from these menus. 

After connecting to the system, select the failed debug step from the Debug Steps menu, 
and follow the instructions given in the Instruction Pane. Note that the steps are shown 
in the chronological order. For example, in any chosen step, assume that the diagnostic 
steps passed successfully. 

Most diagnostics failures require more than one step to debug them. This is the reason 
multiple debug paths and instructions are shown in the Instruction Pane for each step. 

The switch connections in the SR5048 and SR5068 paths are set by the debugger after 
selecting a debug step. To reset the diagnostic path manually, select the path from the 
TAS5048 Configuration and TAS5068 Configuration menus. 

Click the Next button to proceed to the next step in the debugging procedure.  

Make sure to reconnect the cables as shown in Setup Guide before beginning to debug 
another diagnostics path. 
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6.4. Test Validation Errors 

The Validate CDMA Suite function from the Execute Menu examines the test parameters 
in the suite. This operation can significantly reduce the risk of problems during test 
execution by detecting parameter conflicts beforehand. Some of the errors that could 
occur during suite validation are listed below.  

Insufficient hardware for test; [Instrument] not detected. 

The indicated instrument is required to run the test, but was not found. Make sure the 
indicated instrument is on the GPIB bus, set to present in the Communications window, 
and set to the correct GPIB address. 

Insufficient hardware for noise and tone simulation simultaneously. 

If both noise and interfering tones are selected as impairments, this error will be 
generated during suite validation. Both impairments cannot be selected simultaneously. 

Insufficient hardware fader requires noise to be present; Fader not detected. 

If fading is enabled for a test, the SR5500 must be present for the test to execute. 

TASKIT/C2K Requires a FLEX5 RF Channel Emulator. 

If fading is enabled for a test, a SR5500 must be present.  

Parameter out of range. 

Parameters are checked against a maximum range when entered in the Test Settings 
grid. Some parameters have ranges that are affected by the ranges of other parameters. 
Therefore, setting a value for a related parameter could cause the other parameter to be 
out of range. This error is generated as a result. 

6.5. Test Execution Errors 

While a suite is executing, execution errors will be listed in the TASKIT/C2K suite 
window. They can be observed by clicking on the test execution button in the results 
area (lower right) of the suite window. The execution errors will be listed in a grid. Each 
line in the grid represents a single error. For each error, the test number, error number, 
and description is listed. 

This section will elaborate on the error condition for specific test execution errors and 
give helpful information to resolve the error. Note that TASKIT/C2K is designed to handle 
errors without failure. This means that if an error occurs, it will proceed as much as 
possible. Therefore, if a test must be skipped due to errors, its status will be noted as 
“Undetermined”. Once the error is resolved, the test must be executed again to collect 
the results. 
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6.5.1. Mobile Failed to Register 

TASKIT/C2K attempts to register the mobile at the Base Station Emulator once at the 
beginning of a suite. If the call drops while a suite is executed, TASKIT/C2K will setup the 
call again. If call setup fails after a number of attempts, TASKIT/C2K will attempt to 
register the mobile again. Sometimes this causes the call setup to function more 
successfully. Therefore, registering the mobile may occur at the beginning of the suite, or 
during a suite when the call must be re-established. 

There are many possible reasons for failure of the mobile to register. The following 
details some of the causes and suggests ways to resolve the problem. 

Cause #1: The RF Cabling in C2K-ATS is incorrect. 

Use the setup information in this manual or the quick setup poster to verify the cabling. 
Use the System Diagnostic feature described earlier in this chapter to ensure proper 
cabling. 

Cause #2: There is a problem with the Mobile. 

Verify the following information with regards to the mobile: 

• The mobile is a 3G CDMA mobile device. 

• The mobile features an RF interface that is working correctly. 

• The mobile is powered on and has enough power to operate correctly. Is the mobile 
powered by an external power supply instead of its own AC adapter or battery? Is 
that external power supply set correctly for the mobile’s power interface? The mobile 
may be powered on and its User Interface may operate, but the RF interface may not 
operate correctly if it is not powered properly. 

• The mobile is properly interfaced to C2K-ATS. The RF connection to the mobile device 
is reliable and appropriately accounted for in the Mobile correction factor in 
TASKIT/C2K. Note that some RF interfaces can “wear out” with too much physical 
handling. Sometimes these interfaces become intermittent. To help determine such 
a case, adjust the physical RF connection and see if the mobile responds. 

• Set up the mobile device to allow roaming; so that non-home SIDs and non-home 
channels will be allowed (searched). 
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Cause #3: The Mobile setup information is incorrect in TASKIT/C2K. 

TASKIT/C2K can automatically obtain the Mobile’s information using the UDM interface. 
If this is not possible, or if it is considered suspicious, set the Mobile information 
manually in the Mobile window. Pay particular attention to the Channel Number, Band 
Class, NID and SID. For US Cellular CDMA, the default primary channel numbers are 283, 
and 384. In PCS testing there is typically no default channel. The PCS mobile will be 
programmed with a list of channels to scan, and also a list of SID’s to accept. This list is 
usually called a roam list, a preferred roam list, or PRL. Whereas a cellular mobile will 
accept a foreign SID and display the ROAM indicator, the PCS mobile must be told of 
each SID it should accept, along with the home/roam status of that SID. Because of this, 
it can be difficult for a first time user to setup the TASKIT/C2K software for PCS testing 
the first time. It is important to enter the proper Channel/SID/NID combination into the 
software in order to execute tests with success. 

Cause #4: The Mobile does not have enough time or attempts to register. 

Adjust the Registration parameters in the Mobile window to allow more time for 
registration (Registration Period, Registration Timeout) and attempts (Registration Retry, 
Registration Retry Delay, Registration Retry Max). Timer-based registration can be 
selected if the mobile is slow to register. 

Cause #5: The hardware setup information is incorrect in TASKIT/C2K. 

Make sure the settings are correct in the Communications window in TASKIT/C2K (select 
Communications from the Options menu). If an instrument is set to Not Present, be sure 
it is not in the RF cabling configuration. This can cause unpredictable results. 

Cause #6: The Mobile correction information is incorrect in TASKIT/C2K. 

Use the lower half of the Mobile window to configure the Mobile correction information. 
TASKIT/C2K uses this information to ensure an accurate power level reaches the Mobile. 

Cause #7: The system calibration information is incorrect in TASKIT/C2K. 

Perform the System Calibration procedure to ensure the correct calibration information is 
in TASKIT/C2K. 

Cause #8: The incorrect Mobile file is being used in the suite. 

Ensure that the correct Mobile file is being used in the suite. If you have the Mobile file 
open, be sure any changes are saved before the suite is executed. Use the Window menu 
to determine what files are open. 

Other recommendations include: 

• Adjust the Mobile Preferred Registration Type in the Mobile window to see if a 
different registration technique works better for the Mobile. 

• Connect the Base Station directly to the Mobile Station to eliminate suspicious 
hardware and verify the mobile’s configuration.  
Remember to configure the hardware and the software appropriately. 
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• Use a mobile device that is known to be working correctly; ensuring proper C2K-ATS 
operation.  
Remember to adjust the mobile settings for each mobile in use. 

• The mobile is properly isolated from outside RF (other nearby cell sites and signal 
sources). 

6.5.2. Call Setup Failed 

It is possible for the mobile to register, and for the call to fail to be negotiated. Some of 
the reasons for call setup failure are the same as the reasons for registration failure. So it 
is a good idea to go over the previous section for call setup failures as well. In addition, 
here is some information for call setup failure in particular. 

Cause #1: The Mobile radio configuration is not set correctly. 

Adjust the Radio Configuration in the Mobile Window. This value is not always read back 
from the Mobile through the UDM interface, so make sure to set it manually even when 
the Update Mobile feature is used. 

Cause #2: Signal power going to the mobile is insufficient for call setup 

Adjust the Minimum Call Setup Level in the Mobile window to a level sufficient for call 
setup. 

Cause #3: The Mobile does not have enough time or attempts to setup a call. 

Adjust the Call Setup parameters in the Mobile window to allow more time for call setup 
(Call Timeout) and attempts (Call Retry, Call Retry Delay, Call Retry Max). 

Cause #4: Service negotiation fails during mobile originated calls. 

Call setup may fail because of service negotiation problems during mobile originated 
calls. This failure generally occurs when the preferred radio configuration or service 
option in the mobile does not match the radio configuration and/or service option set in 
the base station. The C2K-ATS uses UDM (when available) to set the preferred radio 
configuration and service option in the mobile. If UDM is not installed or these features 
are not implemented for the mobile, try to set the radio configuration and service option 
such that they match in the mobile and base station. 

6.5.3. Impairments Too Severe for Call Setup 

This particular error represents a unique condition. In order to perform registration and 
call setup, TASKIT/C2K configures the RF conditions for no impairments and for a 
minimum signal power level. Once the call is established, the RF conditions are modified 
to perform the test. After the RF conditions are modified, TASKIT/C2K checks if the call is 
still setup. If the call is not setup, this error is generated. This implies that the mobile is 
unable to correctly demodulate enough frames accurately to maintain the connection. 
TASKIT/C2K will list the test status as Undetermined and proceed to the next test. 
Unfortunately, unless the call can remain setup, the test cannot be performed. 
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6.6. Unexpected Results 

This section discusses some of the reasons why variations in results may occur and 
provides helpful information for resolving these issues. 

It is important the C2K-ATS is set up correctly. It is a good idea to review the causes for 
registration failure and call setup failure earlier in this chapter. Some of the reasons for 
unexpected results are the same as some of the reasons for registration and call setup 
failure.  

Pay particular attention to: 

• RF Cabling 

• System Calibration 

• Mobile Correction Factor in the Mobile window 

Mobile devices are expected to perform differently under different RF conditions. For 
example, if the same test is performed at a different frequency, it is common to see a 
difference in the results. Another example is the power level at which the test is 
performed. It is possible to see a difference in the Spurious Response of the mobile 
device when it is transmitting at a different power level. 

6.7. Email Feature 

The following lists some of the common error messages encountered with the Email 
Notification feature:  

• Error Message: The "SendUsing" configuration value is invalid. 

• Possibility: The default SMTP server is not configured.  

• What to look for : You do not see a smtp server configured in IIS ( Internet 
Information Services) in Adminstrator tools in Control panel 

• Solution: enable SMTP service: Control Panel>Add/Remove 
Programs>Add/Remove Win Components>IIS>Details>Enable SMTP. 
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6.8. Frequently Asked Questions 

How do I change the test type in the Suite window? 

It is not possible to change the test type for an existing test. You must first delete the 
existing test. After the test is deleted and the space in the grid is blank, you can select a 
new test type. 

How do I edit the parameters for a test? 

From the Suite window, select the Test Title column for any row. This updates the grid in 
the upper-right part of the window with all editable parameters related to the selected 
test. 

Why do I get an error when I attempt to “Verify Hardware”? 

The Verify Hardware feature in the Communications window attempts to communicate 
with the remote instruments, obtain some information about them, and update the 
information displayed in the window.  

TASKIT/C2K only communicates to the instruments using GPIB. Ensure that your 
computer is equipped with a National Instruments GPIB card and that the instruments 
are correctly connected to the PC using GPIB cables.  

You should also make sure the GPIB addresses of the instruments match the settings in 
the Communications window. Each instrument must have a unique GPIB address. The 
GPIB address must be entered manually in the front panel of each instrument.  

Finally, ensure each instrument is powered-on and ready for remote control.  

Why can’t I edit a value printed in blue? 

Values printed in blue indicate read only parameters. You cannot change these 
parameters directly. Refer to the specific parameters for information on how to change 
them, and when they are read-only. 
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I see “Over Range” or “Under Range” errors on the 8960 front Panel, is this a 
problem?  

This is not a problem. During the course of a suite execution, TASKIT/C2K sets up test 
conditions using a variety of system configurations. These changes include switching 
instruments in and out of the forward and reverse path. These changes cause wide 
variations of path loss.  

Because it is not possible to simultaneously change system configurations and Base 
Station Emulator offsets, there are short instances where the forward and reverse path 
losses are not accurately specified in the Base Station Emulator. This is when this error 
is displayed.  

The error is not automatically cleared from the screen even when the problem is 
resolved.  

Spirent engineers have spent considerable time verifying that at test execution time, all 
levels and offset values are correct. This ensures that “over range” or “under range” 
conditions do not really exist. 
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